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1: Introduction 
The Selenia®, based on the M-IVTM Mammography X-ray System, uses an Image 
Acquisition system that includes a digital image receptor. This receptor, which covers an 
area of 24 cm x 29 cm, is a direct-capture detector using an amorphous selenium 
photoconductor. At the Acquisition Workstation the user selects x-ray exposure 
technique factors, adds patient identification data, acquires, processes, and displays the 
digital images. The images are then either processed for printing and transmitted to 
peripheral hard copy laser film printer or sent to a diagnostic review workstation or both. 
Contrast and brightness are set automatically and can be adjusted by the user prior to 
printing or viewing. Hard-copy printers and a diagnostic review workstation are 
available as options. 

The patient is prepared for the procedure in the same manner as for a film-based system. 
The Acquisition Workstation provides direct digital acquisition system advantages in 
system efficiency and productivity including: 

• Patient demographics are associated with the electronic image. 
• Technologist comments can be associated with the image. 
• The technologist is assisted through the steps of image acquisition. 
• Possible image destinations are provided via configurable settings. 
• The technologist may review past acquisitions (including priors), to see previous 

captures, and then resend, and/or remark them. 
 

1.1 Intended Use 
   

 

 Caution: Federal law restricts this device to sale by or on the order of a physician. 
   

The Selenia is intended to produce radiographic images of the breast. Its intended use is 
for the production, storage, and diagnostic review of digital screening, diagnostic, and 
needle localization mammography. 

The system is to be used in a radiology or clinic exam room environment in a hospital, 
outpatient clinic, or a breast imaging center. Mammography technologists operate the 
system for the production and storage of digital mammograms. The system may also be 
used for quality control purposes and other clinical or research related activities by 
medical physicists and radiologists certified in accordance with MQSA standards. 

• The Selenia Acquisition Workstation display is not approved for final interpretation 
of examinations. Final interpretations should be done from either films or with the 
diagnostic review workstation. Images shown on the Acquisition Workstation 
display are for quality assurance or confirmation purposes only. 

• Only images produced by recommended laser printers, or an approved diagnostic 
review workstation, should be used for final interpretation of examinations. For 

Chapter 1:  
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compatible printers, see the latest product data sheets for the system, which can be 
obtained from Hologic® or your sales representative. 

 

1.1.1 Indications For Use 
The Selenia Full Field Digital Mammography System generates digital mammographic 
images that can be used for screening and diagnosis of breast cancer. The Selenia Full 
Field Digital Mammography System is intended for use in the same clinical applications 
as traditional screen-film mammographic systems. Mammographic images can be 
interpreted on either hard copy film or the diagnostic review workstation. 

1.1.2 Contraindications 
There are no known contraindications. 

1.1.3 Potential Adverse Effects 
The following is a list of potential adverse effects that apply to mammography and are 
also applicable to digital mammography using the Selenia. 

• Excessive breast compression 
• Excessive x-ray exposure 
• Electric shock 
• Infection 
• Skin irritation, abrasions, or puncture wounds 

 

1.2 Intended Use for the User Guide 
Always refer to the User Guide for instructions on using the system. 

1.3 Summary of Clinical Studies 
This information is available in the document MAN-02233. 

1.4 Product Complaints 
Report any complaints or problems in the quality, reliability, safety, or performance of 
this product to Hologic. If the device has caused or added to patient injury, immediately 
report the incident to Hologic. (See the title page for contact information.) 

1.5 Technical Support 
Refer to the title page of this manual for contact information for product support. 
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1.6 Warranty Statement 
Except as otherwise expressly stated in the Agreement: i) Equipment manufactured by 
Hologic is warranted to the original Customer to perform substantially in accordance 
with published product specifications for one (1) year starting from the date of shipment, 
or if Installation is required, from the date of Installation (“Warranty Period”); ii) digital 
imaging mammography x-ray tubes are warranted for twenty-four (24) months, during 
which the x-ray tubes are fully warranted for the first twelve (12) months and are 
warranted on a straight-line prorated basis during months 13-24; iii) replacement parts 
and remanufactured items are warranted for the remainder of the Warranty Period or 
ninety (90) days from shipment, whichever is longer; iv) consumable Supplies are 
warranted to conform to published specifications for a period ending on the expiration 
date shown on their respective packages; v) licensed Software is warranted to operate in 
accordance with published specifications; vi) Services are warranted to be supplied in a 
workman-like manner; vii) non-Hologic Manufactured Equipment is warranted through 
its manufacturer and such manufacturer’s warranties shall extend to Hologic’s 
customers, to the extent permitted by the manufacturer of such non-Hologic 
Manufactured Equipment. Hologic does not warrant that use of Products will be 
uninterrupted or error-free, or that Products will operate with non-Hologic authorized 
third-party products. 

1.7 Hologic Cybersecurity Statement 
Hologic continuously tests the current state of computer and network security to 
examine possible security problems. When necessary, Hologic provides the updates to 
the product. 

For Cybersecurity Best Practices documents for Hologic products, refer to the Hologic 
Internet site. 

1.8 Quality Control Requirements 
The facilities in the United States must use the Quality Control Manual to create a 
Quality Assurance and Quality Control program. The facility must create the program to 
meet the requirements of the Mammography Quality Standards Act or to be accredited 
by ACR or another accreditation body. 

The facilities outside the United States can use the Quality Control Manual as a guide to 
create a program to meet the local standards and regulations. 

1.9 Installation Instructions 
Installation instructions are available in the Service Manual. 
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1.10 User Profiles 

1.10.1 Mammography Technologist 
• Meets all requirements that apply to the location in which the Mammography 

Technologist operates. 
• Completed training on the mammography system. 
• Has training in mammography positions. 
• Knows how to operate a computer and its peripherals. 

 

1.10.2 Radiologist 
• Meets all requirements that apply to the location in which the Radiologist operates. 
• Knows how to operate a computer and its peripherals. 

 

1.10.3 Medical Physicist 
• Meets all requirements that apply to the location in which the Medical Physicist 

operates. 
• Knows about mammography. 
• Has experience with digital imaging. 
• Knows how to operate a computer and its peripherals. 

 

1.11 Training Requirements 
In the United States, users must be Registered Radiologic Technologists meeting criteria 
to perform mammography. The mammography users must meet all applicable MQSA 
personnel requirements under FDA guidelines for conventional and digital 
mammography. 

The user has options available for training, which include but are not limited to: 

• Onsite applications training by a Hologic Clinical Services Specialist 
• Onsite on the job training also known as peer training  
Additionally, the user manual is a guide for directions on how to use the system. 

All users must make sure that they receive training on correct operation of the system 
before use on patients. 

Hologic does not accept the responsibility for injury or damage from wrong system 
operation. 
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1.12 Terms and Definitions 
Accession Number A DICOM term that refers to a RIS-created number that 

uniquely identifies a visit to a site by a patient. 
ACR American College of Radiology 
Ag Silver 
AEC Automatic Exposure Control. A method that limits the amount 

of radiation a patient receives. 
collimator Device at the x-ray tube that limits the area of the receptor that 

is exposed. 
dialog box A pop-up window that requires a user decision and a mouse or 

trackball click before another activity can occur. 
DICOM Digital Imaging and Communications in Medicine. An 

industry standard specification for communication between 
medical imaging equipment. 

digital marker A software mechanism that marks an image to show some 
information (normally orientation). 

FAST Paddle™ Fully Automated Self-Adjusting Tilt Paddle system 
Grid Element within the Digital Image Receptor that reduces the 

scatter radiation during exposure 
HIS/RIS Hospital Information System/Radiology Information System. 

Generic term for non-PACS systems which track the Patient 
demographics and ordered radiological studies 

HTC™ High Transmission Cellular Grid 
kV Kilovolts: One of the x-ray exposure settings. 
login/logout The process of logging into and out of the Operating System of 

the Acquisition Workstation 
LUT Look-Up Table (LUT). An image processing function that 

replaces one image pixel value with a different image pixel 
value. 

Mag Magnification 
mA Milliamperes. One of the x-ray exposure settings. 
mAs Milliampere-seconds. An electrical term used in x-ray exposure 

settings 
Mo Molybdenum 
Modality Worklist 
(MWL) 

A list of scheduled procedures normally kept by a RIS or 
PACS. 

MPPS Modality Performed Procedure Step. A DICOM service to 
allow the RIS (or another device) to know about work 
performed on the Acquisition Workstation. 

MQSA Mammography Quality Standards Act 
Operating System (OS) The software control system which runs all functions of a 

computer. 
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Outputs A list of devices to which the accepted image is sent. The 
devices can be a combination of archives, workstations and 
film printers. 

PACS Picture Archiving and Communications System. A computer 
and network system for the transfer and archive of digital 
medical images 

PPS Status The condition of a Performed Procedure Step being "in 
progress", "completed", or "discontinued". 

Procedure A generic medical protocol which contains a set of images 
(Views) which are acquired under certain conditions, and are 
performed together for a one purpose (for example standard 
screening). There is no Procedure instance UID item because a 
Procedure is a generic item in DICOM. DICOM supports the 
identification of requested Procedures. 

Rh Rhodium 
ROI Region of Interest 
RIS Radiology Information System 
Series A set of images acquired by a single tech for a single Patient 

and Procedure on a particular modality with a fixed body part, 
laterality and view position. DICOM uniquely identifies the 
series with a globally unique instance UID. Based on this 
description, each individually acquired DR image on the 
Acquisition Workstation is also an individual series. 

Sign-in The process of user identification to the Acquisition 
Workstation application. 

Sign-out The process in which a user exits the Acquisition Workstation 
application, but the user does not logout of the OS. 

Smart Paddle™ A paddle with a release knob on each side which allows the 
paddle to move from one side of the image detector to the 
other. The system identifies a Smart Paddle installed on the 
compression device. 

TEC Tissue Exposure Control mode, an enhanced Manual Exposure 
Control (MEC) mode. 

technique Combination of x-ray parameters (kV, mA, etc.) for a specified 
view in a procedure. 

UPS Uninterruptible Power Supply. 
View The combination of a single x-ray image and a specified set of 

conditions under which the image was acquired. The View is 
not part of DICOM nomenclature, but in the context of DR, is 
approximately synonymous with a DICOM image object. 

W Tungsten 
Wildcard Character A keyboard character that represents one or many characters, 

for example the * or ?. 
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1.13 International Symbols 
This section describes the International Symbols on this system. 

 

Type B Applied Part 

 

Protective Earth terminal 

 
"OFF" (power) 

 

"ON" (power) 

 
"OFF" for part of the equipment 

 
"ON" for part of the equipment 

 

Power Standby 

 

Discard electrical and electronic equipment separately from standard waste. 
Send decommissioned material to Hologic or contact your service 
representative. 

 
Dangerous Voltage 

 
Manufacturer 

 
Date of Manufacture 

 

Caution—Radiation 
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1.14 Warnings, Cautions, and Notes 
Descriptions of Warnings, Cautions, and Notes used in this manual: 

 WARNING! The procedures that you must follow accurately 
to prevent possible dangerous or fatal injury. 

 
 

 Warning: The procedures that you must follow accurately to 
prevent injury. 

 
 

 
Caution: The procedures that you must follow accurately to prevent 

the damage to equipment, loss of data, or damage to files 
in software applications. 

 
 

 
Note Notes show additional information. 
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2: General Information 
2.1 Warnings and Precautions 

Read and understand this manual before you use the system. Always follow all the 
instructions in this manual. 

This system is for use by qualified Operators only. The Operators must have experience 
in the principles of mammography before following the instructions contained in this 
manual. 

 

This system is classified as CLASS I, TYPE B APPLIED PART, IPX0, permanently 
connected equipment, continuous operation with short term loading per IEC 60601-1. 
There are no special provisions to protect the system from flammable anesthetics or 
ingress of liquids. 

   
   

 
 

 WARNING! Risk of electric shock. Only connect this 
equipment to supply mains with Protective 
Earth. 

 

   
   

 

 WARNING! Only trained Service Engineers authorized 
through Hologic can open any of the panels. 
This system contains lethal voltages. 

 

   
   

 

 WARNING! Electrical equipment used near flammable 
anesthetics can cause an explosion. 

 

   
   

 

 WARNING! After power failure, remove the patient from the 
system before you apply power. 

 

   
   

 

 WARNING! To correctly isolate the system, attach only 
approved accessories or options to the system. 
Only approved personnel can change the 
connections. 

 

   
   

 

Chapter 2:  
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 WARNING! Keep a 1.5 meter safe distance between the 
patient and any non-patient devices. 
Do not install non-patient system components 
(like the Workflow Manager, the diagnostic 
review workstation, or the hard copy printer) in 
the Patient Area. 

 

   
   

 

 WARNING! For North American electrical safety 
requirements, use a Hospital Grade receptacle to 
supply a correct Ground. 

 

   
   

 
 

 Warning: The user or a servicing engineer must correct 
problems before the system is used. 

 

   
   

 

 Warning: The user must prepare for preventive maintenance 
by an approved servicing engineer. 

 

   
   

 

 Warning: This system can be dangerous to the patient and the 
user. Always follow the safety precautions for x-ray 
exposures. 

 

   
   

 

 Warning: The disk drives installed in this system are a Class I 
Laser Product. Prevent direct exposure to the beam. 
Hidden laser radiation exists if the case to a disk 
drive is open. 

 

   
   

 

 Warning: Only qualified users can use this system. 
 

   
   

 

 Warning: Control the access to the equipment according to 
local regulations for radiation protection. 

 

   
   

 

 Warning: Keep your full body behind the radiation shield 
during the exposure. 
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 Warning: This device contains dangerous material. Send 
decommissioned material to Hologic or contact your 
service representative. 

 

   
   

 

 Warning: The equipment has motors. You must be careful 
when you adjust the equipment for patient use. 
Observe equipment and patient at all times during 
setup. If a chair is necessary, use an adjustable chair 
set above its minimum height. 

 

   
   

 

 Warning: Put the footswitches away from the patient and C-
arm area to prevent any accidental footswitch 
operation. When the patient has a wheelchair, put 
the footswitches away from the area. 

 

   
   

 

 Warning: Do not leave the patient during the procedure. 
 

   
   

 

 Warning: Keep the hands of the patient away from all buttons 
and switches at all times. 

 

   
   

 

 Warning: You increase the patient dose to high levels when 
you increase the AEC exposure adjustment. You 
increase the image noise or decrease image quality 
when you decrease the AEC exposure adjustment. 

 

   
   

 

 Warning: If a paddle touches possible infectious materials, 
contact your Infection Control Representative to 
remove contamination from the paddle. 

 

   
   

 

 Warning: The bar code scanner installed in this system is a 
Class II Laser Product. Prevent direct exposure to the 
beam. Hidden laser radiation exists if the cover is 
opened. 
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 Warning: The Face Shield does not protect the patient from 
radiation. 

 

   
   
 

 
 

 
Caution: Do not use any hot source (like a heating pad) on the 

image receptor. 
 

   
   

 

 
Caution: Never turn off the Acquisition Workstation or Value 

Console Circuit Breaker except in emergency. The circuit 
breaker can turn off the Uninterruptible Power Supply 
(UPS) and risk data loss. 

 

   
   

 

 
Caution: To prevent possible damage from thermal shock to the 

Digital Image Receptor, follow the recommended 
procedure to turn off the equipment. 

 

   
   

 

 
Caution: Risk of data loss. Do not put any magnetic media near or 

on devices that create any magnetic fields. 
 

   
   

 

 
Caution: The system is a medical device and not a normal 

computer. Only make approved changes to the hardware 
or software. Install this device behind a firewall for 
network security. The computer virus protection or 
network security for this medical device is not supplied 
(for example, a computer firewall). The network security 
and anti-virus provisions are the responsibility of the 
user. 

 

   
   

 

 
Caution: To prevent errors and possible data loss, only use 

approved accessories with this equipment. 
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2.2 Radiation Safety 

2.2.1 Exposure Duration 

Table 1: Factors That Limit Exposure Duration 

Normal Factors Abnormal Factors 

Manual mAs 
Timer 

• Release of the X-ray button before the exposure 
ends. 

• Exposure longer than the preset "back-up time". 
• The independent safety hardware back-up timer. 
• Detection of a generator fault. 

 

 
 

2.2.2 Operator Radiation Shield 
The radiation shield meets the requirements of 21CFR 1020 and IEC 60601-2-45.2001. The 
shield has a rating of a 0.5 mm Pb (lead) equivalent and is permanently installed. 

 
Caution: Use care when cleaning the X-ray Shield to avoid 

excessive force and movement of the shield. 
 

   
 

 
Note Verify the shield integrity every day before use. 

 

 
 

2.2.3 Patient Face Shield 
The Patient Face Shield keeps the face of the patient out of the radiation field. 

2.2.4 Exam Room Door Indicators 
• The system provides for an external Power-On indicator. 
• The system provides for an external X-ray Exposure In Progress indicator. 

 

2.3 Mechanical Safety 
The equipment meets the requirements of IEC 60601-1, UL 60601, and CSA 22.2 No. 601.1 
by these safety features: 

• The C-arm rotation braking is ensured upon loss of power. 
• Compression release is disabled when a localization paddle is installed. 
• Motorized compression force has a limit of 200 N (45 lb.). 
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2.4 Emergency Off Switches 
The Emergency Off switches remove the power from the Gantry. Do not normally use 
the Emergency Off switches to turn off the system. See Emergency Off Switches on page 23. 

2.5 Interlocks 
• Display of 58 Newtons (13 lb.) or greater of compression force disables the C-arm 

vertical drive and rotation. 
• Installation of a Localization Paddle disables the automatic compression release 

functions. 
• Release of an X-ray button before the end of the exposure ends the exposure. 
• Misalignment of the Light Field Mirror or the Filter prevents an x-ray exposure. 
• Installation of an 18 x 24 cm shifting paddle prevents the x-ray exposure if the 

detected paddle position does not match the View. 
 

2.6 Compliance 
This section describes the mammography system compliance requirements and the 
manufacturer responsibilities. 

2.6.1 Compliance Requirements 
The manufacturer is responsible for the effects of safety, reliability, and performance of 
this equipment with the following provisions: 

• The electrical installation of the room complies with the appropriate requirements. 
• The equipment is used in accordance with the User Guide. 
• Assembly operations, extensions, re-adjustments, modifications, or repairs are 

performed by authorized persons only. 
• The installed network and communications equipment must comply with an IEC 

Standard, and the complete system (network/communications equipment and 
Selenia Mammography System) must be installed to comply with IEC 60601-1 and 
IEC 60601-1-1. 

 
 

 
Caution: Medical Electrical Equipment needs special precautions 

about EMC and must be installed, put into service and 
used according to the EMC information provided. 

 
 

 
Caution: Portable and mobile RF communications can affect 

medical electrical equipment. 
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Caution: The use of unauthorized accessories and cables can result 

in increased emissions or decreased immunity. To keep 
the isolation quality for the system, attach only approved 
Hologic accessories or options to the system. 

 
 

 
Caution: The Medical Electrical (ME) Equipment or ME System 

should not be used adjacent to or stacked with other 
equipment. If adjacent or stacked use is necessary, make 
sure that the ME Equipment or ME System operates 
correctly in this configuration. 

 
 

 
Caution: This system is intended for use by healthcare 

professionals only. This system may cause radio 
interference or may disrupt the operation of nearby 
equipment. It may be necessary to take mitigation 
measures, such as re-orienting or relocating the equipment 
or shielding the location. 

 
 

 
Caution: Changes or modifications not expressly approved by 

Hologic could void your authority to operate the 
equipment. 

 
 

2.6.2 Compliance Statements 
The manufacturer states this device is made to meet the following requirements: 

• CAN/CSA - ISO 13485-03 Medical Devices – Quality Management Systems – 
Requirements for Regulatory Purposes (Adopted ISO 13485:2003 second edition, 
2003-07-15) 

• CAN/CSA C22.2 NO. 60601-1-08 Medical Electrical Equipment – Part 1: General 
Requirements for Basic Safety and Essential Performance (Adopted IEC 60601-1:2005, 
third edition, 2005-12), includes Corrigendum 1:2011; also CAN/CSA C22.2 NO. 
601.1-M90 (R2005) Medical Electrical Equipment Part 1: General Requirements for 
Safety 

• EN 60601-1:2006 Medical Electrical Equipment. General Requirements for Basic 
Safety and Essential Performance; also EN 60601-1:1990 +A1+A11+A12+A2+A13 
Medical Electrical Equipment—General Requirements for Safety 

• FDA, 21 CFR [Parts 820, 900 and 1020] 
• IEC 60601-1 Ed. 3.0:2005 Medical Electrical Equipment – Part 1: General 

Requirements for Basic Safety and Essential Performance; also IEC 60601-1 Ed. 
2.0:1988 +A1+A2:1995 Medical Electrical Equipment—General Requirements for 
Safety 
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• IEC 60601-1-1Ed. 2.0:2000 Medical Electrical Equipment - Part 1-1: General 
Requirements for Safety - Collateral Standard: Safety Requirements for Medical 
Electrical Systems 

• IEC 60601-1-2 Ed. 3.0:2007 Medical Electrical Equipment – Part 1-2: General 
Requirements for Basic Safety and Essential Performance - Collateral Standard: 
Electromagnetic Compatibility – Requirements and Tests 

• IEC 60601-1-3 Ed. 2.0:2008 Medical Electrical Equipment – Part 1-3: General 
Requirements for Basic Safety and Essential Performance –Collateral Standard: 
Radiation Protection in Diagnostic X-Ray Equipment; also IEC 60601-1-3 Ed. 1.0:1994 
Medical Electrical Equipment – Part 1: General Requirement for Safety -3. Collateral 
Standard: Requirements for Radiation Protection in Diagnostic X-ray Equipment 

• IEC 60601-1-4 Ed. 1.1:2000 Medical Electrical Equipment – Part 1-4: General 
Requirements for Safety - Collateral Standard: Programmable Electrical Medical 
Systems 

• IEC 60601-2-28 Ed. 2.0:2010 Medical Electrical Equipment - Part 2-28: Particular 
Requirements for the Basic Safety and Essential Performance of X-ray Tube 
Assemblies for Medical Devices; also IEC 60601-2-28 Ed. 1.0:1993 Medical Electrical 
Equipment – Part 2: Particular Requirements for the Safety of X-Ray Source 
Assemblies and X-ray Tube Assemblies for Medical Diagnosis 

• IEC 60601-2-32 Ed. 1.0:1994 Medical Electrical Equipment – Part 2: Particular 
Requirements for the Safety of Associated Equipment of X-ray Equipment 

• IEC 60601-2-45 Ed. 3.0:2011 Medical Electrical Equipment – Part 2-45: Particular 
Requirements for Basic Safety and Essential Performance of Mammographic X-Ray 
Equipment and Mammographic Stereotactic Devices; also IEC 60601-2-45 Ed. 
2.0:2001 Medical Electrical Equipment Part 2-45: Particular Requirements for the 
Safety of Mammographic X-ray Equipment and Mammographic Stereotactic Devices 

• ANSI/AAMI ES60601-1:2005 (IEC 60601-1:2005, MOD) Medical Electrical Equipment, 
Part 1: General Requirements for Basic Safety and Essential Performance, includes 
amendment (2010); also UL 60601-1 1st Edition: Medical Electrical Equipment, Part 
1—General Requirements for Safety 
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2.7 Label Locations 
 

 
Figure 1: Selenia Label Locations 

 

 
Figure 2: Value Console Label Locations 
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Table 2: Label Descriptions  
Label Identification Description 

1 

 

Serialized Device Label 

2 

 

X-ray Tube Serial Number 

3 

 

Emergency Stop Switch 

4 

 

Wheelchair Warning for Footswitch 

5 N/A Vendor Footswitch Label 
6 

 

Electrical Shock Warning 

7 

 

Patent Label 

8 
 

 

System Nameplate Label for IEC 60601-1 Third 
Edition Compliant Systems 

 

Gantry Nameplate Label for IEC 60601-1 
Second Edition Compliant Systems 

9 

 

Potential Equalization Terminal 

10 
 

 

Acquisition Workstation Nameplate Label for 
IEC 60601-1 Third Edition Compliant Systems 
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Table 2: Label Descriptions  
Label Identification Description 

 

Acquisition Workstation Nameplate Label for 
IEC 60601-1 Second Edition Compliant 
Systems 

11 
 

 

UL (Underwriters Laboratories) Certification 
Label for IEC 60601-1 Third Edition Compliant 
Systems 

 

UL (Underwriters Laboratories) Certification 
Label for IEC 60601-1 Second Edition 
Compliant Systems 

12 

 

Warning for Remote UPS Power Switch 

13 

 

X-ray Device Warning 

14 

 

Technical Support Contact Label 

15 
 

"ON" for Part of the Equipment 

16 
 

Radiation Caution 

17 

 

Temperature Limit Label 

18 

 

Patient Dose Label 
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3: System Components and Controls 
3.1 System Description 

The Selenia is available with an Acquisition Workstation or a Value Console.  

 
Figure 3: Selenia System Description 

 

Figure Legend 

1. Selenia Acquisition Workstation 
Contain the image processing electronics and 
show the user interface. 2. Value Console 

3. C-arm The C-arm provides a platform for the x-ray 
tube, compression systems, and the digital 
image receptor. A pivot mechanism connects it 
to the Gantry.  

4. Gantry The Gantry contains the electrical and 
mechanical subsystems for the Selenia. The C-
arm and the Gantry comprise the Tubestand. 

5. Dual-function Footswitches Enables hands-free C-arm vertical travel and 
compression movements. 

 

 
 

Chapter 3:  
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3.2 Film Printer 
Selenia accepts film printers. Printed films display the patient information, exposure 
techniques, projection, and facility information. 

3.3 System Power Controls 

3.3.1 Input Power Circuit Breakers 

Location of Circuit Breaker Description 

 
Figure 4: Gantry Circuit Breaker 

• At the lower right corner of the 
back panel 

• Removes the power for service 
or in an emergency  

• Up is turned On. Down is 
turned Off. 

• When turned off, a system 
restart is required. Restart the 
system following Procedure for 
Startup on page 31. 

 
Figure 5: Acquisition Workstation Circuit Breaker 

• On the back of the Acquisition 
Workstation behind the shield. 
The Value Console Circuit 
Breaker (not shown) is on the 
back of the Value Console. 

• Use only in an emergency. 
• If the circuit breaker was used, 

wait until the beeps stop, then 
turn on the circuit breaker. The 
system automatically restarts. If 
the UPS does not respond 
automatically, reset the UPS. 
See How to Turn On or Reset the 
Uninterruptible Power Supply 
(UPS) on page 39. 
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3.3.2 Emergency Off Switches 

• Press any Emergency Off Switch to remove 
Gantry power. 

• Rotate the switch one-quarter turn to reset. 
• Restart the system after any Emergency Off 

Switch is pressed. See the procedure in Restart 
After the Emergency Off Switch was Activated on 
page 38. 

 
Figure 6: Emergency Off Switch 

 

 
Figure 7: Acquisition Workstation Emergency Off 

Switch 

 
Figure 8: Value Console Emergency Off Switch 

 
Figure 9: Gantry Emergency Off 

Switches 
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3.4 Acquisition Workstation Controls and Display 

3.4.1 Acquisition Workstation 

 
Figure 10: The Acquisition Workstation 

Controls 

 
Figure 11: The Selenia Value Console 

Controls 

Figure Legend 

1. Circuit Breaker  

2. Emergency Off Switch 

3. Selenia Display 

4. Trackball 

5. CD-RW Drive 

6. Left and Right Keypads 

7. Selenia Acquisition Workstation UPS 
(Uninterruptible Power Supply) Reset 
Button (on lower right back) 

8. Bar Code Scanner 

9. Selenia Keyboard 

Figure Legend 

1. Computer 

2. Bar Code Scanner 

3. Left and Right Keypads 

4. Keyboard 

5. Display 

6. Emergency Off Switch 

7. Mouse 

8. Circuit Breaker 

9. CD-RW Drive 

10. UPS 
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3.4.2 Keypads 
The Keypads provide Power On, X-ray, and Compression Release functions. 

 
Figure 12: Keypad Controls 

 Figure Legend 

1. Power On button 

2. Power On indicator light 

3. X-ray Indicator lights on both panels 

4. X-ray buttons, one on each side of the 
keyboard. Press both at the same time 
to begin an x-ray exposure and hold 
until the tone stops. 

5. Compression Release button 

 

 

 
 

3.4.3 Keyboard and Trackball or Mouse 
 

 
Figure 13: Selenia Keyboard 

 Figure Legend 

1. Selenia Function keys 

2. Trackball (Acquisition Workstation) 

3. Future Use 

4. Standard keyboard keys 

5. Standard arrow keys 

6. Standard number keypad 

7. Mouse (Value Console) 
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3.4.4 Keyboard and Screen Controls 
Use the trackball or the function keys to change Exposure techniques. 

 
Figure 14: Selenia Function Keys on the Keyboard 

 

Table 3: Selenia Function Keys 

Key Name Function 

 
Exposure 
Mode 

Changes AEC, TEC, and Manual exposure modes.  

 
Filter Changes the Filters. 

The Filter options depend on the x-ray tube. The Molybdenum 
system has Mo and Rh. The Tungsten system has Rh and Ag. 

 
kV Up Increases kV. 

 
kV Down Decreases kV. 

 
mAs Up Increases mAs. 

 
mAs Down Decreases mAs. 

 
Grid   Changes the Grid Position (In or Out). 

 
Focal Spot Changes the Focal Spot size (Small or Large). 

 
Breast Density  Changes the TEC Breast Density settings. 

 
AEC position  Moves the AEC Sensor position. 

 
New Entry  Opens the New Patient Entry dialog box. 

 
Close 
Procedure  

Closes the Procedure. (Disabled when MPPS is installed). 

 

 
 

3.4.5 Bar Code Scanner 
The Bar Code Scanner speeds the entry of data from records with bar codes. 
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3.4.6 The Selenia Display 
Features Display 

• Meets the DICOM requirements. 
• Press the recessed dial (on the right 

side) to show a menu. 
• Press and hold the recessed dial to 

turn the Display On/Off. 
• Green indicator lights when Display is 

turned on. 
• Ability to tilt.  

 

 
 

3.5 Tubestand Controls and Displays 
 

 
Figure 15: Tubestand 

Tubestand Components 

1. The Gantry 

2. The C-arm 
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3.5.1 Gantry Controls and Displays 
 

Gantry Controls 
1. The C-arm Rotation Angle Displays on both sides of the 

Gantry show the C-arm angle.  

2. The Emergency Off Switches on each side of the Gantry 
remove power from the Tubestand.  

3. Gantry Rotation Switches (if installed) on each side of the 
Gantry move the C-arm to a programmed position.    

4. The Input Power Circuit Breaker at the rear of the Gantry 
provides the overload protection.  

5. Dual-Function Footswitches activate C-arm and 
Compression Device movement. 

 
Figure 16: Gantry Controls 
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3.5.2 C-arm Controls and Displays 

C-arm Controls 

1. Tubehead Controls 

2. Compression Device 

3. Rear of the C-arm Side Rails 

4. Rear of the Image Receptor 

 
The Tubehead Controls on either side of 
the x-ray tube side covers provide the 
Collimator Override, C-arm Rotation, 
and Light Field functions. 

 
The Compression Device contains the 
AEC Sensor control and position LEDs, 
and displays compressed breast 
thickness and force. Handwheels allow 
manual compression control. 

 
The rear edges of the C-arm Side Rail 
have recessed push-button controls for 
motorized compression and C-arm 
movement. An additional C-arm 
Rotation button is available on the rear 
of the Image Receptor. 
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Compression Device Controls and Displays 

Figure Legend 

1. Compression Handwheels 

2. AEC Sensor Position Controls  

3. AEC Sensor Position Display 

4. Compression Force Display 

5. Compression Thickness Display 

 
Figure 17: Compression Device 

 

 
 

3.5.3 Dual Function Footswitches 

1. Press the footswitch to activate. 
2. Release the footswitch to stop 

motorized movement. 

Figure Legend 

1. C-arm Down 

2. C-arm Up 

3. Compression Down 

4. Compression Up 
 

Figure 18: The Dual Function Footswitch 

 
 

 Warning: Put the footswitches away from the patient and C-
arm area to prevent any accidental footswitch 
operation. When the patient has a wheelchair, put 
the footswitches away from the area. 
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4: Startup, Functional Tests, and Shutdown 
4.1 Procedure for Startup 

 

Table 4: System Startup Procedures 

Step Description 

1. Reset the Emergency Off 
Switches. 

 
Figure 19: Emergency Off Switch 

• Two on the Gantry 
• One on the Acquisition Workstation (or Value 

Console) 

2. Make sure that the circuit 
breakers are turned On. 

 
Figure 20: Gantry Circuit Breakers 

 
Figure 21: Acquisition Workstation Circuit Breaker 

3. Perform Pre-Startup Checks. a. Look for open or loose panels, missing 
hardware, and indications of damage. 

b. Inspect the radiation shield for chips, cracks, 
breaks, and for tight attachments. 

c. Inspect the paddles for small cracks and wear. 

d. Remove any obstructions to the Operator view 
and C-arm movement. 

Chapter 4:  
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Table 4: System Startup Procedures 

Step Description 

4. Turn On the Selenia. 
(If the Acquisition Workstation 
does not start, reset the UPS for that 
unit. See How to Turn On or Reset the 
Uninterruptible Power Supply (UPS) 
on page 39.)  

Figure 22: Power On Button and LED 

a. Press the Power On button (Item 1). The green 
LED (Item 2) illuminates. 

b. Allow the time for initialization and diagnostic 
tests to complete. 

5. Log on to the Operating 
System. 

When the Logon dialog box appears: 

a. Enter your user name (case sensitive) for the 
Operating System. 

b. Enter your Operating System password. 

c. Select OK or press the Enter key. 

6. Log in to the Application. When the Login to System dialog box appears: 

a. Select your ID from the drop-down list. 

b. Enter your password (case sensitive). (Asterisks 
appear in the field.) 

c. Select OK or press the Enter key. 
 

 

 
Note If the system remains on over the night, reboot the system 

daily to ensure best performance. 
 

 

 
Note If the system was turned off for 30 minutes or longer, the 

detector temperature needs time to adjust. Allow a 
minimum of 1 hour before you acquire images on a patient. 
The Launch dialog box disappears when the wait time is 
finished. 

If it has been less than 30 minutes, click Dismiss in the 
Launch dialog box. 

 
 

 
Note If during the internal checks, the system detects a fault 

condition, a message appears and startup is suspended until 
the problem is resolved. 
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4.2 Controls and Functional Tests 
Perform these functional tests monthly. 

 
Note The C-arm movement is disabled when compression force 

of 58 N (13 lb.) or greater is applied. 

Table 5: Monthly Control Function Tests 

Function Control Test 

Counterclockwise C-arm 
Rotation 

 

C-arm and Gantry Rotation 
Switches 

  

Press and hold the C-arm button 
and confirm the following actions: 
• C-arm rotates. 
• Angle display changes. 
• Rotation stops when you release 

the button. 
• Press and hold a Center button 

and confirm C-arm moves to 
zero degree position. 

Clockwise C-arm Rotation 

 

C-arm and Gantry Rotation 
Switches 

  

Press the button and confirm the 
following actions: 
• C-arm rotates. 
• Angle display changes. 
• Rotation stops when you release 

the button.  
• Press and hold a Center button 

and confirm C-arm moves to 
zero degree position. 
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Table 5: Monthly Control Function Tests 

Function Control Test 

Compression Down 

 

 

 

1. Press the button. 
2. Confirm the compression brake 

engages and the light field lamp 
illuminates. 

3. Confirm the Compression Down 
movement stops: 
• When you release the 

button. 
• At the compression down 

force limit. 
• At the lower compression 

travel limit. 
 

Compression Up 

 

 

 

1. Press the button. 
2. Confirm the compression brake 

does not release. 
3. Confirm the Compression Up 

movement stops: 
• When the Compression 

device reaches the upper 
compression travel limit. 

• On release of the button. 
 

Compression Release 

 

 

 

1. Press the button. 
2. Confirm the following actions: 

• The compression motor 
brake releases. 

• The compression device lifts 
approximately 10 cm. 

Note: The system disables all 
compression release functions when a 
localization paddle is installed, or 
system defaults are configured for 
manual compression release. 
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Table 5: Monthly Control Function Tests 

Function Control Test 

C-arm Up 

 

 

 

1. Press the button. 
2. Confirm the C-arm Up 

movement stops: 
• When you release the 

button. 
• When the C-arm reaches the 

upper travel limit. 
3. Apply more than 58 N (13 lb.) 

compression and confirm the C-
arm does not move. 

 

C-arm Down 

 

 

 

1. Press the button. 
2. Confirm the C-arm Down 

movement stops: 
• When you release the 

button. 
• When the C-arm reaches the 

lower travel limit. 
 

Light Field Lamp 

 

 

 

1. Press the button. Confirm the 
light turns on for a short time.  

2. Confirm the light field lamp 
turns on when a Compression 
Down button is activated. 
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Table 5: Monthly Control Function Tests 

Function Control Test 

Collimator Override 

 

 

 

1. Press the light field button then 
the collimator button. 

2. Confirm the Collimator moves 
to the next field size. 

3. Repeat the Steps 1 and 2 until 
you move through all 
Collimator field sizes. 

 

Smart Paddle 

 

 

 

1. Install a Smart Paddle. 
2. Rotate the release knob on the 

side of the paddle from the lock 
to the shift position. 

3. While you hold the knob in the 
shift position, move the paddle 
into a detent position.  

4. Turn on the light field lamp. 
5. Confirm the collimator position 

matches the paddle position. 
6. Repeat this procedure for the 

other two paddle positions. 
7. Apply compression and confirm 

the paddle does not unlock.  
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Table 5: Monthly Control Function Tests 

Function Control Test 

AEC Position 

 

 

 

1. Select an AEC mode. 
2. Change the AEC position with 

the compression device arrow 
button. 

3. Confirm the indicator positions 
on the sides of the device and 
Acquisition Workstation display 
match the current position. 

4. Move past position 7 or 1. 
5. Confirm the Auto position 

indicator on the compression 
device illuminates and the 
display indicates Auto. 

6. Select the AEC arrows on the 
display and repeat Steps 3 to 5. 

7. Use the keyboard function key 
and repeat steps 3 to 5.  
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4.3 Monthly System Tests 
• Test all Emergency Stop Switches. Follow the on-screen reset procedure. 
• Change the AEC Sensor Position switch, and make sure the compression device 

indicator and the Acquisition Workstation display change. 
• Test all buttons on all keypads and footswitches. Include the compression release on 

the Acquisition Workstation. 
• During Compression Device tests make sure the thickness and force displays change. 
• During C-arm rotation tests, confirm that the LED Angle displays change. 

 

4.4 How to Restart the System 

4.4.1 Restart From Sleep Mode 
1. To activate the system, move the trackball or mouse. 
2. In the Login dialog box, enter reboot for the user name and password. 
3. Wait for the system to restart. 
4. Log on to the Operating System, then Log on to the Application software. 
5. If the system was off for less than 30 minutes, select Dismiss in the Launch dialog 

box. 
 

4.4.2 Restart After the Emergency Off Switch was Activated 
1. Turn the Emergency Off switch by one-quarter turn clockwise to reset the switch. 
2. When the Power Panel dialog box displays, "Communication with the generator is 

lost," examine the Emergency Off Switches and the circuit breaker:  
 

 
Caution: Do not close this dialog box by using the X in the upper 

corner. 
 

• If the Gantry power is turned on, select the Cancel button. 
• If the Gantry power is turned off, and the Emergency Off Switches and the 

circuit breaker are set correctly, select the OK button. 
3. When the "Link established with generator" dialog box appears, select OK. 
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4.4.3 How to Turn On or Reset the Uninterruptible Power Supply (UPS) 

 
Figure 23: The Acquisition Workstation UPS 

Switch Lever 
 

Figure 24: Value Console UPS Switch 

1. Find the Acquisition Workstation UPS 
switch lever on the lower, right of the 
back panel. 

2. Press the switch lever down and hold for 
two seconds or until the UPS beeps. 

3. Start the Acquisition Workstation. 
 

1. Find the Value Console UPS 
switch, on the front of the UPS. 

2. Press and hold the UPS switch for 
two seconds or until the UPS 
beeps. 

3. Start the Console. 

 

 
 

4.4.4 How to Turn Off the UPS 
1. Make sure that the Acquisition Workstation or the Value Console are off. The UPS 

system begins to beep repeatedly and can now be shut down. 
2. Find the UPS switch. (See the previous figures.) 
3. For the Acquisition Workstation, press and hold the switch lever down for two or 

three seconds or until the UPS beeps. For the Value Console, press and hold the UPS 
switch for two or three seconds or until the UPS beeps. 

4. When the power is restored, press the UPS switch one time to turn on the UPS. 
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4.5 How to Log Out 
There are two methods to log out of the application. The system will remain on and 
another user can log in to use it. 

Table 6: The Log Out Methods 

Method 1 Method 2 

1. Select the Sign Out button. 

 
Figure 25: The Sign Out Button 

2. Select the Exit button. 
3. Select Yes. 

1. Select File>Exit. 
2. Select Log out of the computer?. 

 
Figure 26: Exit from Acquisition Station Dialog Box 

3. Select Yes. 
 

 
 

4.6 How to Shut Down the System 
1. Select File>Exit. 
2. Select Power off the computer? from the dialog box. See the figure Exit from 

Acquisition Station Dialog Box on page 40. 
3. Select Yes. 

 

 
Note If a message appears and indicates that there are spool jobs, 

select log off or wait until the jobs are finished. (The spool 
continues again later.) Hologic recommends that you allow 
the jobs to complete before shut down. 

 

   
 

 
Caution: Do not use a circuit breaker or Emergency Off switch as a 

routine method to turn off the Selenia. 
 
 

 
Caution: Never turn off the Acquisition Workstation or Value 

Console Circuit Breaker except in emergency. The circuit 
breaker can turn off the Uninterruptible Power Supply 
(UPS) and risk data loss. 
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5: The Selenia Accessories 
5.1 Patient Face Shield 

Remember to examine the Face Shield condition before use each day. 

5.1.1 How to Install the Face Shield on the Tubehead 
1. Put the tab ends on the open end of the Face Shield into the slots on the tubehead 

mount. 
2. Slide the Face Shield into the tubehead mount until the Face Shield locks in position. 

 

5.1.2 How to Remove the Face Shield 
1. Pull the rear sides of the shield away from the tubehead. 
2. Slide the shield off the mount. 

 
Figure 27: Installation of the Face Shield 

 
 

 Warning: The Face Shield must be attached for all exposures 
except magnification case studies. 

 
 

 Warning: The Face Shield does not protect the patient from 
radiation. 

 
 

Chapter 5:  
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5.2 Compression Paddles 
There are 19 compression paddles for Screening and Diagnostic Procedures. Twelve of 
the nineteen paddles are Smart Paddles and have mechanisms that allow manual lateral 
movement (both left and right). The x-ray collimation moves with the Shifting 
Compression Paddle position. The other seven paddles include five magnification 
paddles and two large 24 x 30 cm paddles. 

5.2.1 How to Install the Compression Paddles 
1. Align the mounting pins on the rear frame of the paddle with the mounting holes in 

the Compression Device. 
2. Push the compression paddle into the Compression Device until the paddle stops. 
3. Carefully pull the paddle out approximately 3 mm until the paddle clicks into 

position. 
 

5.2.2 How to Remove a Compression Paddle 
1. Hold the paddle by the metal sides of the frame. 
2. Pull the paddle in a straight line from the mounting holes. 

 
Figure 28: Mount the Compression Paddle 

 

 
 

5.2.3 Maintenance and Cleaning 
Clean the paddles after each use. See Maintenance and Cleaning on page 103 for cleaning 
instructions. 
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5.2.4 Smart Paddle System 
A release knob on each side of the Smart Paddle allows it to move from one side of the 
image detector to the other. This enables the Technologist to optimize the breast position 
and imaging within the active area of the Image Receptor, especially when Lateral Views 
of a small breast are required. 

To shift a Smart paddle: 

1. Select a View on the Acquisition 
Workstation. 

2. Rotate the release knob on the side of the 
paddle from the lock to the shift position. 

3. While you hold the knob in the shift 
position, move the paddle to match the 
View. The paddle locks into position on a 
detent. 

4. Release the knob to lock it in position. 
5. Confirm the paddle is locked into position. 
6. Activate the light field lamp and confirm 

the collimator matches the paddle 
position. 

 
Figure 29: Shifting Compression Paddle 

 

 
 

5.2.5 FAST Paddle Use 
The Fully Automatic Self-adjusting Tilt (FAST) Paddle is for use when the composition of 
the breast tissue does not allow uniform compression across the complete breast with a 
flat compression paddle. For these patients, not enough compression can cause an image 
to appear to be out of focus at the anterior region from both involuntary motion and not 
enough compression. 

The FAST paddle use with this type of breast provides these features: 

• Reduced motion artifacts, because the compression is more effective. 
• The compression is more uniform from the chest wall to the nipple. 
• Maximum patient comfort, because over compression at the chest wall is prevented. 
The FAST paddle automatically tilts when the compression is applied. The paddle is in a 
flat position until a compression force of approximately 20 pounds (88 Newtons) is 
applied. The paddle then tilts until its maximum angle is reached at a force of 
approximately 30 pounds (132 Newtons). 

The FAST paddle does not require excessive compression, but you must use enough 
compression to prevent the movement of the breast. You should use a consistent amount 
of compression, especially for related left and right views. 

The FAST paddle may not be best for breasts that are equal or symmetrical in thickness 
from the chest wall to the anterior area of the breast. 
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5.2.6 How to Realign the Paddle Front Edge 
If the front edge of the paddle with 30 lb. (132 N) of 
compression force applied is not in alignment with the 
front edge of the Image Receptor, follow this procedure. 
1. Release the compression and remove the paddle. 
2. Loosen the hardware that holds the paddle to the 

frame. On a standard screening paddle, or a 
frameless spot paddle, turn the paddle upside down 
and loosen the hardware one complete turn. On a 
FAST paddle, use a hex wrench to loosen the 
paddle. 

3. Turn the paddle over (if necessary) and loosen the 
two inside screws. See the figure Alignment of 
Adjustment Screws on page 44. 

4. Install the paddle and apply 30 lb. (132 N) of 
compression force. 

5. Move the paddle to the correct position. (Do not 
release the compression.) 

6. Tighten both inside screws that you loosened in step 
3. 

7. Release the compression and remove the paddle. 
8. Turn the standard screening or the frameless spot 

paddle upside down and tighten the hardware that 
fastens the plastic paddle to the frame. 

9. Install the paddle and apply 30 lb. (132 N) of 
compression force. 

10. Confirm that the front edge of the paddle is aligned 
to the front edge of the Image Receptor. 

 
Figure 30: Alignment of the 

Paddle 

 
Figure 31: Alignment of 

Adjustment Screws 
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5.2.7 Identification of Compression Paddles 

Routine Screening Paddles 

 
18 x 24 cm Screening Paddle 

 
18 x 24 cm FAST Paddle 

 

 
24 x 30 cm Screening Paddle 

 
24 x 30 cm FAST Paddle  

Small Breast Paddle 
 

 
 

Contact and Spot Compression Paddles 

 
10 cm Contact Paddle  

15 cm Contact Paddle 
 

Ultrasound Paddle 

 
7.5 cm Spot Contact Paddle 

 
Frameless Spot Paddle 
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Magnification Paddles 

 
7.5 cm Spot Magnification 
Paddle 

 
10 cm Magnification 
Paddle 

 
15 cm Magnification 
Paddle 

 
10 cm Magnification 
Localization Paddle 

 
10 cm Magnification 
Perforated Localization 
Paddle 

 

Use the Magnification paddles when the Magnification Platform is installed. 
 

Localization Paddles 

 
10 cm Perforated Localization Paddle 

 
10 cm Rectangular Open Localization Paddle 

 
15 cm Perforated Localization Paddle  

15 cm Rectangular Open Localization Paddle 
 

 
 

About the Localization Paddles 
The Installation method is the same for all Paddles. The system locks out Auto 
Compression Release when a Localization Paddle is installed. The AEC Sensor may 
require repositioning. 
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5.3 Magnification Platform 
When the Magnification Platform is installed, the HTC grid automatically retracts and 
the default values for Magnification x-ray exposure techniques are set. 

5.3.1 How to Install the Magnification Platform 
1. Remove the Face Shield (see Patient Face Shield on page 41). 
2. Remove the compression paddle. 
3. Move the Compression Device above the slots in the C-arm. 
4. Hold the Magnification Platform by the support brackets and align the hooks of the 

bracket with the mounting slots on the C-arm. 
5. Put the hooks into the C-arm slots. 
6. Push the frame down so that the clips lock the Platform in position. 
When the platform is installed, you can use only the Magnification paddles. (See 
Magnification Paddles on page 46.) 

5.3.2 How to Remove the Magnification Platform 
1. Remove the Magnification paddle. 
2. Press the locking clips on the Magnification Platform down to release the hooks. 
3. Lift the Magnification Platform up and out by the support bracket. 
4. Reinstall the Face Shield. 

 
Figure 32: Magnification Platform Installation 
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5.4 The Localization Crosshair Device 
The Localization Crosshair device, used with a localization paddle enables the location of 
a specified spot on the breast. 

5.4.1 How to Install the Crosshair Device 

 
Figure 33: Installation of the Crosshair Device 

1. Remove the Face Shield from the tubehead. 
2. Move the Compression Device below the C-arm mounting slots. 
3. Hold the Crosshair device by the support brackets and slide the hooks into the C-arm 

slots. 
4. Push the device down to the locked position. 
5. Install the Localization paddle on the Compression Device. 

 

5.4.2 How to Remove the Crosshair Device 

1. Rotate the Crosshair device to the left 
or right. 

2. Press the two locking levers inside each 
mounting arm. 

3. Lift the device up and from the C-arm. 
Be careful. The device is top heavy. 

4. Install the Face Shield. 

 
Figure 34: Crosshair Locking Levers 
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5.4.3 Localization Crosshair Device to the Localization Paddle Alignment 
 

 
Note Before you perform the following adjustment, make sure 

the Localization paddle is aligned to the edge of the image 
receptor. See How to Realign the Paddle Front Edge on page 44.  

 

1. Install a rectangular localization paddle. 
2. Loosen the adjustment lock screw on the bottom 

of the Crosshair Device. (See Number 1 in the 
image to the right.) 

3. Put a piece of white paper on the breast tray so 
that you can see the shadows of the crosshairs. 

4. Move the Localization paddle approximately 6 
cm above the image receptor. 

5. Turn on the light field. 
6. Move the Crosshair Device until the rectangle of 

light aligns with the opening in the localization 
paddle. 

7. Tighten the adjustment screw. 

 
Figure 35: Adjustment Lock Screw 

 

 
 

5.5 The Magnification Crosshair Device 

 
Figure 36: Installation of the Magnification Crosshair Device 

1. Remove the face shield from the tubehead. 
2. Align the Magnification Crosshair Device with the grooves of the face shield rails. 
3. Push forward until the device locks into position. 
4. To remove the Magnification Crosshair Device, pull and slide the assembly toward 

you. 
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6: The User Interface 
6.1 Introduction to the User Interface 

The process of image acquisition, enhancement, and output is done through three 
screens: 

• Select a Patient screen 
• Patient Views screen 
• Preview Images screen 
When you select an option on a screen, other screens may appear for information entry or 
selection of additional options. This manual covers the screens that appear while you are 
logged in as a "tech". 

• Select a Patient 

 

• Patient Views  

 

• Preview Image  

 
 

 
 

Chapter 6:  
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6.2 Select Patient Screen 

6.2.1 Introduction 
The Select a Patient screen appears when the system application loads. This screen allows 
you to locate a patient, and access non-routine Acquisition Workstation options with no 
patient selected. 

 
Figure 37: The Select a Patient Screen 

 

Figure Legend 

1. Menu Bar - Menu Bar on page 63 

2. Search for a Patient - Select a Patient on page 53 

3. Patient Query - How to Search the Acquisition Workstation Database (Local 
Exams) on page 53 

4. Today’s Worklist - More Information about Searches on page 53 

5. Exposure Techniques - Exposure Information on page 58 

6. Add/Edit the Patient Information - How to Add a New Patient on page 54 

7. Add/Edit a Procedure - New, Edit, Add a Procedure on page 56 

8. Outputs - Image Output on page 57 

9. Special Modes - Special Modes Buttons on page 78 

10. Generator Status - Generator Status on page 79 

11. System Message - System Messages on page 79 
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6.2.2 Select a Patient 
A patient can be added to the system or already exist and be selected from a list. There 
are two places to search for an existing patient, the worklist which is a list of scheduled 
patients from a Modality Worklist Provider and the Local Exams which are the patients 
on the computer in the workstation. 

How to Query the Modality Worklist Provider 
1. Select the Worklist tab in the upper left area of the Select a Patient screen. 

 

 
Note If you changed the date from the ‘today’ setting, select the 

Today’s Worklist tab. 

2. Enter the query data. 
• If you use the Bar Code Scanner to input the query data, the procedure opens. 
• If you use the keyboard to type the query data, select the Query button, then 

select the patient from the list to open the procedure. 
 

 
Note This query does not search the local Acquisition 

Workstation database, Local Exams. An Asterisk is not 
necessary for this search. 

 

 
If your search for one match with a Patient ID or Accession Number has results, the 
patient Procedure opens automatically. Selecting a patient adds them to the Local Exams 
database. 

How to Search the Acquisition Workstation Database (Local Exams) 
1. Select the Local Exams tab in the upper, left area of the Select a Patient screen. 
2. Select the Patient Name or ID tab. 
3. Enter the Patient Name or ID in the Search box. Or, enter part of a Patient Name or 

part of an ID number and use an asterisk for the missing characters. 
4. Select the Search button or press the Enter key. 
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More Information about Searches 
• When part of the patient name is entered, the system applies a wildcard character at 

the end of the name. 
 

 
Note You can use the asterisk (*) as a wildcard character to 

increase your search. For example, when you enter R*ph, 
Patients with the names Randolph and Rudolph will 
display. If you use a wildcard character, make sure that you 
include a minimum of one other character. 

• You can use one or more of the search fields. 
• You can limit the query to a date range. 
• Most worklist providers require information in the Patient ID and Accession Number 

fields to match. Data in these fields is case sensitive. 
• You must include the caret (^) character between the name parts (for example, 

DOE^J). 
 

6.2.3 How to Add a New Patient 
The Patient area of the screen allows you to Add a New Patient. 

1. Select New in the Patient pane to display the New Patient Entry dialog box. 

 
Figure 38: New Patient Entry Form 

2. Enter the Patient demographic information. Use the Tab key or the trackball to move 
through the fields. You must enter information in the Fields that have an asterisk. 
• The Patient Name fields must contain only letters or numbers. 
• The Clear button clears the information you entered.  
• The Cancel button closes the form without your changes. 
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3. Select the Accept button to enter the Patient in the Acquisition Workstation Local 
Database. The Patient Views screen displays. 

 

 Warning: Verify the Patient Demographic Application 
information before you acquire an image. 

 
 

6.2.4 How to Edit the Existing Patient Data 

 
Figure 39: The Edit Patient Dialog Box 

 
 

 
Note This procedure only changes the patient information for 

images in the case study not yet taken. The Acquired images 
must be resent using Image Management and Resend, after 
the information is edited. See Image/Spool Management on 
page 70. 

 
 

 
Caution: Do not edit the patient information if you use a Modality 

Worklist. See About Patient Information Edits with a 
Modality Worklist and PACS. 

To edit the Patient information: 

1. Select Edit in the Patient Box to display the Edit Patient dialog box. 
2. Make the changes to the fields that have wrong or missing information. Use the Tab 

key or the trackball to move through the fields. 
 

 
Note The Cancel button closes the dialog box without any 

changes. The Clear button clears last name, first name, 
DOB, and age. 

3. Select the Accept button. 
4. Verify that the correct changes appear in the screen before you acquire a new image. 
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6.2.5 New, Edit, Add a Procedure 

How to Add a New Procedure 
1. Open an existing patient. 
2. Select New in the Procedure pane.  

 
Figure 40: New Procedure, Edit a Procedure, and Add a Procedure Buttons 

3. Select Yes in the Creating a New Procedure will close the current Procedure dialog 
box. Any open procedure will close. 

4. When the New Procedure dialog box appears, enter a new Accession Number. 

 
Figure 41: New Procedure Dialog Box 

 
 

 
Note The Cancel button closes the dialog box without any 

changes. The Clear button clears the Accession number. 

5. Select the Procedure Description from the drop-down list. 
6. Select the Accept button. 
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How to Edit a Procedure 
1. Select the Edit button in the Procedure area of the screen. 
2. Change the Accession Number. You cannot change the Procedure selection. 
3. Select the Accept button. 

 

How to Add a Procedure 
The Add a Procedure function allows you to have many procedures open at the same 
time. 

1. Select the Add button in the Procedure pane. 

 
Figure 42: Add a New Procedure Dialog Box 

 
 

 
Note The added procedure must use the same Accession Number 

as the open procedure. If you do not plan to use the same 
Accession Number, select the New button and follow How 
to Add a New Procedure on page 56. 

2. From the drop-down list, select the Procedure to add. 
3. Select the Accept button. 
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6.2.6 Image Output 

 
Figure 43: Select the Output 

Before acquiring an image, verify that you selected the correct output. All patient images 
must be printed or committed to a PACS. Select the Output group to use for this 
procedure from the drop down list. To edit existing or create new output groups, see 
Outputs on page 67.  

There is also a statement of the current number of Jobs in the Queue. 

6.2.7 Exposure Information 

The Exposure Pane 

 
Figure 44: Exposure Techniques 

The top, left side displays the status of these options: 

• Compression Force Mode 
• Compression Release 
• Compression Thickness 
• Collimation Mode 
• Collimation Size 
• Image Size 
• Paddle ID (type and position) 
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Select the Exposure Techniques in the bottom area. Use the up/down arrows in the 
Exposure Mode area (the lower, far-left box) to select the Exposure Mode. The exposure 
default values for that mode appear to the right.   

About Exposure Modes 
Table 7: Exposure Modes 

Exposure 
Modes 
(Item 1) 

Operator 
Adjustments 

Where the function is in the Techniques Pane 

Auto-Filter Select the AEC 
Exposure Adjustment 
(item 2); AEC Sensor 
(item 3) (Positions 1-7 
or Auto). 

 
Auto-kV Select AEC Exposure 

Adjustment; AEC 
Sensor. 

 
Auto-Time Select kV; Filter; AEC 

Exposure Adjustment; 
AEC Sensor. 

 
TEC Select Breast 

Density (item 4), then 
select Accept or 
change the Exposure 
Techniques, which 
puts you in Override 
(Manual) Mode. 

 

Manual Manually calculate 
and select all x-ray 
techniques and 
Exposure Factors (kV, 
Filter, and mAs).  

 
 

 
Note When you change the mode, all Exposure Techniques reset 

to the default values for that mode. 
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About the Manual Exposure Mode 
In the Manual mode the Operator sets all Exposure Techniques. The default values 
appear when you select the View, then you make any necessary adjustment. 

• To change an Exposure technique with the trackball, scroll to the value with the 
up/down arrows, or select the option box. 

• To change an Exposure technique with the keyboard, press the Function Key for the 
item at the top of the keyboard. 

 

About the TEC Exposure Mode 
The Tissue Exposure Control (TEC) Mode is an enhanced Manual Exposure Control 
mode.  

1. Before you position and compress the breast, select the Breast Density type on the 
Acquisition Workstation screen or press the Breast Density key. 

 
Figure 45: Breast Density Options 

2. Compress the breast. The x-ray exposure techniques for kV, mAs, and filter update. 
3. Select the Accept button in the Breast Density area (or press the Enter key). When 

"Ready" displays in the Generator Status message area, the system is ready to acquire 
an image. 

 
Figure 46: Accept TEC Exposure Techniques 
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If you change one or more of the parameters (kV, mAs, or filter), the system enters the 
Override Mode. When the Override message displays, the system is ready to acquire an 
image. 

 
Figure 47: The Override Mode 

There are three methods to exit the Override Mode and return to TEC mode:  

• Change the Breast Density setting. 
• Release the compression then compress the breast. 
• Select TEC mode a second time. 

 

AEC Exposure Mode 
The Automatic Exposure Mode (AEC) uses the pre-exposure Scout pulse, and for some 
modes the compression thickness to calculate the exposure. 

The AEC options are Auto-Filter, Auto-kV, and Auto-Time. See About Exposure Modes on 
page 59 for the exposure technique selections available with each mode. 
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AEC Exposure Adjustment Settings 

 
Note AEC exposure adjustment is not available in all geographic 

regions. 

You can use the AEC Exposure Adjustment controls to increase or decrease the target 
pixel value. Each step changes the target pixel value by approximately 15% and makes a 
related change in dose. See figure AEC Exposure and Sensor Position Adjustments on page 
62. 

Set this control in a range from +4 to -3 to increase or decrease the exposure. This 
adjustment remains until you change the adjustment or restart the system. 

 Warning: You increase the patient dose to high levels when 
you increase the AEC exposure adjustment. You 
increase the image noise or decrease image quality 
when you decrease the AEC exposure adjustment. 

 

   
 

 Warning: An increased exposure adjustment leads to a higher 
dose to the patient. Keep the patient dose as low as 
practical to get good image quality. 

 

   

 
Figure 48: AEC Exposure and Sensor Position Adjustments 
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AEC Sensor Position Indicator Settings 
Select one of the seven positions to indicate the area of interest for AEC calculations. Or, 
select Auto AEC where a larger area is tested. 

 
Note Always confirm the position of the AEC Sensor before an 

AEC exposure. 

The AEC Sensor Position has eight available positions. 

• The Positions 1 through 7 are manually selected, from the chest wall edge (position 1) 
to the nipple edge (position 7). 

• Position 8 (Auto) automatically positions the sensor.  

To change the AEC Position selection, use: 

• The buttons on the compression device. 
• The AEC Pos key on the keyboard. 
• The AEC position arrows on the Acquisition Workstation display. 
Set the AEC Sensor Position after you compress the breast. The displays on the side of the 
Compression Device and the lower right corner of the screen indicate the position setting. 

AEC Alarm Messages 
When the system cannot use the selected AEC mode to acquire an Image, one of the 
following messages displays. 

Table 8: AEC Alarm Messages 

Message Reason and Corrective Action 

Calculated Exposure 
Time Less Than Min 

The AEC Sensor is over a thin or small area of breast tissue. 
Use the AEC Sensor in a position under the breast tissue. 
Alternately, use AutoTime and a lower kV. 

Calculated Exposure 
Time Exceeds Max 

Very dense breast tissue, an implant, pacemaker, or other 
anatomy changed the AEC sensor. Move the manual AEC 
sensor where there are no obstructions. Alternately, use 
AutoTime and a higher kV. 

1. Select OK in the dialog box. 
2. Select the Reset Generator button. 
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6.2.8 Menu Bar 
The Menu Bar provides easy access to non-routine Acquisition Workstation options. 
These options are available while the Acquisition Workstation application runs unless a 
dialog box or Procedure is opened. 

The table below shows the Menu Bar options when a patient procedure is not selected. 

Table 9: Menu Bar Options and Functions 
Menu Options Function 

File Exit Exit from Acquisition Workstation 
Edit Standard Setup Select the startup default values (Standard Setup 

Screens on page 65). 
View Order Editor Change the view order (View Order Editor on page 

66). 
User Setup Add, edit, delete a user profile (Add or Edit a User on 

page 66). 
Outputs Add, remove output devices (Outputs on page 67). 

Admin Image/Spool 
Management 

Retrieve the images from the Image/spool 
(Image/Spool Management on page 70). 

Protect Patients Protect or Unprotect patient records (Protect Patients 
on page 70). 

Manage Queues Find a specified job in the queue (Manage Queues on 
page 71). 

Eject Remove a disk from CD/DVD drive (Eject on page 
72). 

Import Copy images from a CD to the system (Import on 
page 72). 

Retrieve Priors View previously-acquired images (Retrieve Priors on 
page 75). 

PPS Status* Additional options (when MPPS Service is installed) 
for close of a procedure (MPPS Status on page 75). 

Calibrate Access calibration procedures (Calibrations on page 
76). 

Test Patterns Access test pattern procedures (Test Patterns on page 
76). 

DR Device Control Access by Service personnel (DR Device Control on 
page 76). 

Available Disk Space Displays status of hard disk drive space (Available 
Disk Space on page 77). 

Stereotactic** Enable or Disable Stereo 
mode** 

Engage or disengage the stereo mode. Available 
when the StereoLoc II is installed. 

Info About the Acquisition 
Workstation 

(Info Menu on page 77) 
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Table 9: Menu Bar Options and Functions 
Menu Options Function 

* This option appears when the MPPS Service is installed. 
** This option appears when the Stereotactic Service is installed. 
 

 
 

Edit Menu Function 

Standard Setup Screens 

 
Figure 49: The Setup Screen 

1. Select Edit>Standard Setup. 
2. Use the trackball or the keyboard Tab key to move between fields. 
3. Use the trackball or arrow keys to display and select options. 
4. Select the Close button to exit the dialog box. 

 

 
Note When Manual Collimation is selected, the function that 

automatically changes the Collimation when a paddle is 
changed or moved turns off. 

 

 
 

Set Technique Defaults 
Select the Set Technique Defaults button to display the Technique Default Setup screen. 
You must set the default values for all modes. 

1. Select Manual Exposure Mode and select the system startup defaults. 
2. Change the mode to Auto-time and select the options. 
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3. Continue to change the mode and select the options for all remaining exposure 
modes including Magnification modes. 

 

View Order Editor 

 
Figure 50: View Order Editor 

1. Select Edit>View Order Editor. 
2. Select the procedure from the drop-down menus. 
3. Select the Views for each Procedure: 
4. Left click and hold on the View icon to move and change the order. 
5. Select Close. Your view order preferences load when you log in. 
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Add or Edit a User 
A signed-in user can add or delete a user at the same or lower level. To access the Edit 
User options, select Edit>User Setup. 

 
Figure 51: The Edit Users Dialog Box 

 

Table 10: User Setup Options 
Option Steps 

• Add a new user 1. Select New. 
2. Enter the requested information. The password must 

contain a minimum of 6 characters. 
3. Select the Accept button. 

• Edit a user 1. Select your name from the list. 
2. Select Edit. 
3. Change the Initials, if necessary. 
4. If requested, enter the Password. The password must 

contain a minimum of 6 characters.  
5. Select the Accept button. 

• Delete a user  1. Select the User to delete. 
2. Select the Delete button. 
3. Select the Yes button to the confirmation prompt. 

• Close the dialog box 1. Select the OK button to close the Edit Users dialog box. 
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Outputs 
To Add New Output Groups: 

1. Select Edit > Outputs. 
2. Select New. 
3. Enter the name for this Output. 
4. Select OK. 
5. Select the new name in the Edit Outputs dialog box. 
6. Select Edit. 

 
Figure 52: Edit Output Device Dialog Box 

 
 
 
 

 

 
Note Outputs are first created during installation. 

7. Select the tab for the type of device. 
• CDRW = CD-RW 
• Laser Camera = Printer 
• Physician Display = Diagnostic Review Workstation, Technologist Review 

Workstation, CAD, etc. 
• Archive = PACS 

8. Select the device name. 
9. Select the Add button to move it to the right column. 
10. To add another output device to the new group, select the tab for the device type. 
11. Select the device name. 
12. Select the Add button. 
13. Select the Accept button when finished with the group. 
14. Select the OK button. 
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To Edit Outputs: 

1. Select Edit > Outputs. 
2. Select an Output name. If the Output keeps its current name, go to step 7. 
3. Select the Copy button. 
4. Enter a new Output name. 
5. Select the OK button. 
6. Select the new name in the Edit Outputs dialog box. 
7. Select the Edit button. 
8. Select the tab for the type of device to add. 
9. Select the device to add. 
10. Select the Add button to move it to the right column. 
11. Select the name of any output in the Devices currently selected column that is not 

needed in the group. 
12. Select the Remove Item button. 
13. Select the Accept button. 
14. Select the OK button. 
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Admin Menu 

Image/Spool Management 
1. Select Admin>Image Management. The Choose a New Patient dialog box appears. 

 
Figure 53: Choose a New Patient Dialog Box 

2. Select the Patient Name tab or the Patient ID tab. 
3. Enter the search information in the Enter Patient Name or ID box. 
4. Select the Search button. 
5. Select a patient from the list. 
6. Select the thumbnail image of the image to resend or repreview. 

• You can select more than one to resend. 
• If there are more than four images, use the arrows on the side to scroll. 

7. Select the Tab for Repreview or Resend. 
8. Continue with directions in The Resend Options on page 73 or The Repreview Option on 

page 74. 
 

 
Note If the commit function is enabled and archive has 

committed the image to storage, the line "Commit: 
Accepted" appears in the information about the image in the 
upper right pane. See the figure Image Management Resend 
Options on page 74. 

 

 
 

Protect Patients 
Use the Protect function to prevent automatic removal of patient records from the hard 
drive. 

1. Select Admin>Protect Patients. 
2. Search for the patient to protect. 
3. Select the patient to protect from the search results. 
4. Select the Protect button at the bottom of the screen. 
5. When the confirmation dialog box appears, select the Yes button. 
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6. Select the Close button. 
 

 
Note To create more space on the hard disk drive, unprotect 

patients who do not need protection. 

To unprotect a patient record: 

1. Select the patient. 
2. Select the Unprotect button.  

 

Manage Queues 
Use Manage Queues to find problem jobs or a specified job in the queues. 

 

 Warning: When you select Delete Job, the job is 
permanently deleted. If you did not send the 
job, resend it to a storage device later. 

 

 

 
Figure 54: Manage Queues 

 

Figure Legend 

1. View the list of available queues. 

2. Enable or disable a job spooler. 

3. Update the list of Queued Jobs. 

4. View the list of jobs in the queue. 

5. Remove the inactive jobs from the queue. Resend stopped jobs. 
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Table 11: How to Use Manage Queues 

Option Steps 

• To find the status of a 
job: 

1. In the Devices list, select the queue to view. 
2. Select the OK button. 

• To delete a job: 1. Select the queue in the Devices list. 
2. Select the Suspend <name> Spooler button. 
3. Select a job from the Queued Jobs list, or Ctrl+click to 

select many jobs. 
4. Verify that the selected job is the job to delete. There 

is no "undo". 
5. Select the Delete from Queue button. 
6. Select the OK button. 

• To resend a stopped job: 1. Select the queue in the Devices list. 
2. Select a job marked ‘Stopped’ from the Queued Jobs 

list, or Ctrl+click to select many jobs. 
3. Verify that the selected job is the job to resend. 
4. Select the Resend Stopped Job button. 
5. Select the OK button. 

 

 
 

Eject 
Select Admin>Eject to open the CD-RW drive drawer when there is a CD in the CD-RW 
drive. 

 
Note When the CD-RW drive is empty, press the button on the 

CD-RW drive to open the drawer. 

When there is a disk in the drive, the drive drawer opens 
only from the menu. To close the drive drawer, press the 
CD-RW drive button. 
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Import 
To import the information from a CD: 

1. Open the CD-RW drive drawer. 
• Press the CD-RW drive button to open the tray if there is no CD in the drive. 
• Select Admin>Eject to open the drive if there is a CD in the drive. 

2. Put the CD that contains the images to import on the tray. 
3. Press the CD-RW drive button to close the tray. 
4. Select Admin>Import. 
5. In the dialog box, find the file (or files) to import. 

• Select a "+" to open a list of folders and/or files. 
• Select the empty box to select the file or folder. 

 

 
Tip: To deselect a file, click the checkmark. When you deselect a 

folder, the files below the folder are not deselected. You 
must clear each file. 

6. Select the Import button. The file is copied from the disk and is available in the 
Select a Patient screen. 

 

 
Note Do Not press the Eject button on the drive while the system 

reads from or writes to the disk. 

If you try to eject or read the CD while the import process 
finishes, you can cause the drive to stop. 
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The Resend Options 

 
Figure 55: Image Management Resend Options 

1. Select the Resend button. 
• To resend all images on the hard disk drive for this patient, select Resend All 

Images. 
• To resend selected images, select the thumbnails of the images to resend, then 

select the Resend Selected button. 
2. Select the Output from the drop-down list. 
3. If the selected Output has a printer, select the Print Image Processing Options. 
4. Select the Resend button. 
5. Select the OK button. 

 

 
Note You cannot change any patient or image object information 

from the resend function. This includes image, LUT 
modifications and DICOM information such as Patient 
name spelling, ID, and comments. To send new information 
you must make a new file with the Repreview function, 
save it, and Resend the new file. 
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The Repreview Option 
1. Select the thumbnail image to review. 
2. Select the Repreview tab, then select the Repreview button. 
3. When you finish reviewing, select the Cancel button. 
4. To create a new file to resend, make any required changes to the markers, comments, 

or use the Edit View function, then click Save. If you select a FOR PRESENTATION 
image, you cannot change the markers and ROI is not enabled. 

5. Make any necessary changes in the Contrast or Density. These changes do not save 
when you save the image.  

6. Select the Save button. 
 

 
Note Make sure that you send the newly-saved image. The 

original is a possible selection. 
 

 
 

Retrieve Priors 
To find the Images in the Local Database, select the Local Exams tab and search for the 
Patient.  

To Retrieve Priors from the PACS system: 

1. Select Admin > Retrieve Priors. 
2. Enter the patient name in the Name field or ID in the ID field (wildcards allowed). 
3. To limit the results to a date range, select the checkbox Search by Date Range, then 

enter the Date Range for the Prior Images. The date format must match the 
configuration setting, (mm/dd/yyyy or dd/mm/yyyy). 

4. Select the Query button or press the Enter key. If the button is not enabled, you need 
more characters in either the Name field or ID field. Select the patient name (or 
names) to import. 
• You can select many patients. 
• You can deselect patients. 
• You can use the title bars to sort by field. 

5. When the Import button activates, select Retrieve and Import. The images import 
into the Acquisition Workstation Local Database.    

6. Select the OK button. 
7. Select the Close button. 
After the import completes, select the Local Exams tab to display the Patient Images. If 
there are more than 50 records in your query request results, adjust your search. 

MPPS Status 
When this optional feature is installed, a menu item is added to sites with the MPPS 
Service Class Provider. Workflow changes with three Close Procedure options instead of 
one option. 
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Calibrations 
When Calibration is needed, the Select a Patient screen remains in Standby and the 
Calibration Needed Alarm message appears in the System Message box. 

When you turn on the system, a message appears if the system needs any calibration. 
You cannot acquire the patient exposures until you perform the required calibration. All 
the review, resend, and administrative functions continue to work. 

 
Caution: It is important to follow the directions on the screen when 

you calibrate a system.  
 

   
   

 

 
Note Clean the detector and acrylic block before you perform a 

Calibration. 

If you are in the Calibration Mode screen by accident, select the End Calibration button. 
If you started the Calibration, but you did not accept images, you can reject the Image 
and exit the Calibration. 

 
Note When you accept one image, do not end the calibration 

before you acquire, view, and accept all the images. 
 

 
 

Test Patterns 

 
Note See DICOM Printer Quality Control in the Selenia Quality 

Control Manual for more information about the SMPTE test 
pattern. 

1. Select Admin>Test Patterns. 
2. From the Output area of the screen: 

• Select the Output Device from the drop-down list. 
• Select the Film Size from the drop-down list. 
• Uncheck the Print True Size check box. 

3. Select the Test Pattern from the Pattern drop-down list. 
4. Select from the options at the bottom of the screen: 

• To view the test pattern Full Screen, select the Preview button. To return to the 
dialog box, click any area on the Full Screen. 

• To send the Test Pattern to the selected output, select the Send button. 
• To remove any files from previous "sends" before you send the current images, 

select the Clean Up button. 
• To exit the Test Pattern option, select Close. 
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DR Device Control 
This function is for use by service personnel. 

Available Disk Space 
This option displays the remaining number of images the hard disk drive and CD can 
hold. 

The system automatically deletes some images/patients at specified levels to get back 
hard disk drive storage space for new procedures. Automatic image removal does not 
include the following: 

 
Note Your service representative can configure your system to 

auto delete rejected images from the Reject Bin. When auto 
delete is not configured, rejected images must be deleted 
manually. 

• Images in a queue to an output device. 
• Images for protected patients. (Make sure that you unprotect patients when you do 

not need their files.)  
• Images that are not successfully committed to an archive device. (Archive devices 

send commitments after Images go to long-term storage.) 
 

 
Caution: If the disk does not have enough available space, the 

system does not acquire an image. A message displays the 
capacity of the disk. Delete unneeded images to restore 
the disk space. 

 

    
 

Info Menu 
The Info menu displays the information about the Acquisition Workstation. 
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Gantry Serial Number and Detector Temperature 
To find the Gantry serial number: 

1. Select the Info tab. 
2. Select About the Acquisition Station. 

 
Figure 56: Location of the Gantry Serial Number 

 

   
 

6.2.9 Special Modes Buttons 

Non-imaging Mode Button 
The Non-imaging mode is available to all users and allows the x-ray exposure without 
the acquisition of images. This mode is not available when you have a patient selected. 
When you select the Non-imaging mode, the Image Receptor deactivates. 
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To access this mode, select the Non-Imaging Mode button. 

 
Figure 57: Non-Imaging Mode Button 

 
 

 
Caution: Protect the Image Receptor from excessive radiation by 

covering it with lead while using the Non-imaging mode. 
 

To exit the Non-Imaging mode, select the End Non-Imaging Mode button. 

The Review Button 
This button is used during the Reject /Unreject process. See How to Accept a Rejected Image 
on page 97. 

The Simulate Capture Button 
This function is for use by service personnel. 

6.2.10 Generator Status 
This area displays the current status of the system. See the figure The Select a Patient Screen 
on page 52. 

6.2.11 System Messages 
The System Messages area displays the system status. 

6.2.12 Alarms 

 
Figure 58: The Alarm Icon 

Alarms are generally output problems that occur due to jobs that fail at the output 
device. The Alarm Icon shows the number of alarms. Select the icon to view the details. 
Erase the alarm to clear it. 
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6.3 Patient Views Screen 

6.3.1 Patient Views 
When you select a patient, the Views for the scheduled Procedure display on the Patient 
View screen in your preset order. The program automatically highlights the first View in 
the sequence. To choose a different View, select that View. 

 
Figure 59: Patient View Screen 

 

Table 12: Actions on the Patient Views screen 
Topic Information 

Work with Views (item 1) Work with Views on page 80 
Add/Edit the Patient Information How to Add a New Patient on page 54 
Add/Edit a Procedure (item 2) New, Edit, Add a Procedure on page 56 
Select the Image Output Image Output on page 57 
Jobs in the Queue (item 3) Displays the number of jobs in the outputs. 
Change Exposure Techniques Exposure Information on page 58 
Acquire the View Acquire Images on page 82 
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6.3.2 Work with Views 

 
Figure 60: Buttons Used on the View Screen 

 

Table 13: View Options 

Option Actions 
Add View (item 1) 1. Select the Add View button.   

2. Select an additional View from the list of Standard 
Mammography Views. To add multiple views, hold 
down the Control key and select the View. 

3. Select the OK button. 
4. Select the new view icon before you acquire the 

image. 

Remove Unexposed (item 2) Unused view icons are automatically reclaimed, but you 
can delete the views with the Remove Unexposed Views 
button.  
1. Select the All button to remove all unused icons, or 

the Selected button then indicate which views to 
delete. 

2. Select the Remove Unexposed button. 

Implant Present (item 3) Select the box if there is an implant present in the breast. 
The box should remain checked for all views in the 
procedure. 

Close Procedure (item 4) 1. Select the Close procedure button. 
2. Select the Yes button to close the procedure or the 

No button stay on the screen. 
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6.3.3 Acquire Images 
The system is ready to acquire images when the Generator Status indicates "Ready" (item 
1 in the figure below), and the X through the x-ray symbol (item 2, in the figure below) in 
the Generator Status box is not displayed. 

 
Figure 61: Ready for Exposure Indicators 
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6.4 Preview Image Screen 

6.4.1 Introduction 
The Preview Image screen appears when you acquire an image. The right side of the 
screen has image tools and buttons to Accept or Reject the image. 

 
Figure 62: The Preview Image Screen 

 

Figure Legend 

1. Acquired Image Display Area 

2. Tools 
 

 
 

6.4.2 The Preview Image 
The Preview Image is a non-diagnostic, processed image for anatomy and position 
confirmation. The Patient Name, ID, and the View appear on a bar on the top of the 
Preview. 

Progressive Preview 
The first preview image appears for a quick check of the breast position. This image 
updates with an image of better quality to check for motion or image artifacts. 
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Film Label Area 
The film label area which is the small rectangle in the upper, left corner is blank in the 
Preview.  

A Digital Marker next to the label displays the Technologist initials and the marker for 
the selected View. You can move or change the marker.  

Hanging Options 
The Images in this manual are displayed in the Dorsal orientation (the Operator faces the 
patient). 

 
Figure 63: Hanging Options 

This option can affect how images display on your diagnostic workstation. Confirm the 
effect of the options with the vendor. 
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6.4.3 Tools for Image Enhancement and Annotation 

Figure Legend 

1. Comments 
2. Markers 
3. Edit View 
4. Implant Present 
5. Zoom/Pan Thumbnail 
6. Crosshair 
7. Measurement 
8. Window/Level 
9. ROI size Drop-down 
10. Set Center/Width 
11. Display AEC Regions 
12. Exposure Index 
13. Exposure Techniques 
14. Reprocess View 
15. Magnification 
16. Full Zoom/Pan 
17. Quick Zoom/Pan 
18. ROI 

 
Figure 64: The Preview Screen Tools 
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Comments 
The comment text is inserted in the DICOM header of the Acquired Image. The 
Diagnostic Review Workstation displays the comments.  

 
Figure 65: Image Comments 

1. Select the Comments button. 
2. Select the Additional Comment checkbox. 
3. Select the field below the checkbox and enter your comment. 
4. Select the OK button to save the comment. 

 

 
Note To remove all comments, select the Clear Comments 

button. To close the dialog box without a change to the 
comments, select the Cancel button. 
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The Edit View Button and Markers 
Select the Edit View button to 
update the DICOM header and 
enable the image to hang correctly 
at the Diagnostic Review 
Workstation. 
The tabs and buttons allow you to 
change just the Marker. 

 
Figure 66: The Markers in the Preview Pane 

 

 
 

How to Use the Marker Function 
1. If the marker is wrong, select the Clear All Markers button  
2. Select the Tab for the set of markers you need. 
3. Select the marker you need. You can select a maximum of three markers from the 

available set for each image. 
4. Move the marker to the correct position. 
If you change a Marker, you change the label on the image, but not the DICOM header. 
You will not see the change on the Patient View page. 

How to Use the Edit View Button Before You Accept the Image 
1. Select the Edit View button. 
2. Select the required view from the displayed list. 
3. Select OK. The correct image displays on the preview screen and the marker and the 

direction the image hangs are correct. 

How to Use the Edit View Button After You Accept the Image 
If the image is Accepted before you notice the wrong view, the incorrect image was sent 
to the selected output. Make the corrections, then resend the corrected image with the 
Image or Spool Management menu. See Image/Spool Management on page 70. 

1. Before you make any changes: 
• If you printed the mislabeled image, find and discard that image. 
• If the image was sent to a Diagnostic Review Workstation, delete the mislabeled 

image. 
• If the image was sent to the PACS, tell the PACS administrator to delete the 

mislabeled image. 
2. Repreview the Image. (See The Repreview Option on page 74.) 
3. Select the Edit View button on the Preview screen. 
4. Select the required view from the displayed list. 
5. Select Save. A new thumbnail image appears. Resend this image. 
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Implant Present 
Select the checkbox on the Patient View screen when an implant exists. When the 
checkbox is selected, the system marks future images with an Implant Present label. The 
checkbox on this screen enables you to change the selection before you accept the image. 

Quick Zoom/Pan 

Quick Zoom/Pan  is active after the image is first displayed, before image 
processing completes. 

1. Select the Quick Zoom/Pan button. 
2. To pan through the image, drag with the right trackball or mouse button. 
3. To turn off the function, select the Quick Zoom/Pan button. 

 

Full Zoom/Pan 

 
Figure 67: Full Zoom/Pan Image 

The Full Zoom/Pan  function becomes available after image processing is 
complete. The box in the thumbnail image on right side of the screen shows where the 
magnification view is in the complete image. With a left click, you can move this box in 
the thumbnail to view any area in the image.  

1. Select the Full Zoom/Pan button.   
2. To move through the image, drag with the right trackball or mouse button. 
3. To turn off the function, select the Full Zoom/Pan button again. 
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ROI 

 
Figure 68: ROI Size Drop-down Menu 

 

Method 1: Draw a custom box. Method 2: Use a pre-defined box. 

1. Select the ROI button. 
2. From the drop-down menu, select 

User Draw. 
3. Click in the image and drag to 

draw the size you need. 
 

1. Select the ROI button. 
2. From the drop-down menu, 

select the size. 
3. Click the area of interest in the 

image. 
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Crosshairs 

 
Figure 69: Preview with Crosshairs 

1. Install a localization paddle. 
2. Acquire the image. 
3. If necessary, select the Zoom/Pan button and move through the image. 

4. Select the Crosshair button . 
5. Select the area of interest in the image. 
6. Drag the crosshairs to the needed position, or select another area. 
7. If necessary, use the Zoom/Pan functions to follow the crosshair lines to the grid 

from the localization paddle. The crosshair lines remain when the Zoom/Pan 
function is enabled and disabled. 
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Measurement 

 
Figure 70: A Measurement on the Preview Screen 

1. Select the Measurement button .  
2. Click the first point then drag to the second point. The distance displays when you 

release the button. 
3. Select the "+" at either end of the line to clear. There lines are not saved with the 

image. 
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Magnification 

Use the Magnification function  to view part of the image at 2X the displayed 
resolution. 

1. Select the Magnification button. 
2. Move the box that appears at the area of interest. 
3. To turn off the magnification function, select the Magnification button a second 

time. 
 

 
Note You can use the magnification function on a Full Zoom 

image. 
 

 
Figure 71: Preview with Magnification 
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Window/Level 

1. Select the Window/Level button . 
2. Select in the image and hold while you move the trackball. 

• Roll Up or Down to change the brightness (Level). 
• Roll Right or Left to change the contrast (Window). 

3. To return to the original settings, double click the image. 
4. Select the Window/Level button to turn off the feature. 

 

 
Note This operation does not change the final, processed Image. 

 

 
Figure 72: The Window/Level Settings 

To enter a known Window/Level value: 

1. Select the field (Center or Width) to change. 
2. Enter a new number. 
3. Select the Set button. 

To return to the original setting, double click the image. 
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Display AEC Regions 
To display the AEC area selected by the system, select the Display AEC Regions 
checkbox. 

• Manual sensors show on the image as a white rectangle with rounded corners. 
• The two Auto Sensor areas show on the image as 1cm by 1cm white squares. 

To hide the AEC areas, deselect the Display AEC Regions checkbox. 

 
Figure 73: AEC Regions 
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Exposure Index 
Use the Exposure Index as a general guide to compare the selected Exposure Techniques 
to the quality of the acquired image. 

• "Image Status: OK" shows that the image processing was applied. 
• "Image Status: Raw" shows that image processing was not applied. 
• A number after the image status shows a problem with the image processing. Reject 

the image. Contact Service Support. 
 

 
Figure 74: Exposure Information 

Figure Legend 

1. Exposure Index-pixel count 

2. Low exposure area—evaluate the 
image for excess noise. Re-acquire, if 
necessary. 

3. Satisfactory, but below ideal 
exposure area 

4. Ideal exposure area 

5. High exposure area—the image is 
more than sufficient. You can reduce 
the radiographic technique for the 
next exposures. 

6. The Exposure Index line related to 
imaging of the ACR phantom 

• For Manual and TEC modes, the Exposure Index calculates an area approximately 
one centimeter from the chest wall on the centerline of the image. 

• For all AEC modes, the Exposure Index calculates for the AEC areas used. 
 

Exposure and Dose/Entrance Surface Exposure Information 

 
Figure 75: Exposure Information 

The exposure information is displayed in the Tools area. An estimate of the average 
glandular organ dose and the entrance surface exposure are displayed. 
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6.4.4 Accept or Reject 
Select Accept or Reject to close the Preview screen. The sequence continues by 
highlighting the next view. 

Accept 
To accept the image, select the Accept button. 
• The full resolution image with all related attributes is marked as accepted in the pool.  

• The system transmits the image to the selected output devices. 
 

Reject 
To reject the image: 

1. Select the Reject button.  
 

 
Note Reject Analysis uses this information (required for Quality 

Control). 
 
 

2. Select the reason for the 
reject. 

 
 

 
Figure 76: The Reject Reasons List 

3. Select the Reject button. The 
system moves the image to 
the Reject Bin. An asterisk 
displays next to the View 
label of a rejected image.  

 
Figure 77: A Rejected Image 
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6.4.5 Additional Information About Accepted/Rejected Images 
After you reject an image, the Preview closes and you can: 

• Re-acquire the rejected View. 
• Select a different View. 
• Close the Procedure. 

 

The Image Repetition Information Dialog Box 
When you accept a second image for the same View, the Image Repetition Information 
dialog box appears.  

1. Select the reason for the repeat. 
2. Close the dialog box. 

 

How to Accept a Rejected Image 
To accept a rejected image: 

1. Reject the image that was taken as the replacement for the rejected image. 
2. In the Patient View screen, select the Review button (below the Output box).  
3. In the Review dialog box, select the tab for the View. 
4. Select the Rejected Image thumbnail image to accept. 
5. Select the Comments button to add or delete comments. 
6. Select the OK button to close the Comments dialog box. 
7. Select the Set Accepted button. 

 
Figure 78: Set Accepted Button on Review Screen 
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8. Select the OK button to close the Review dialog box. 

 
Figure 79: Accept Rejected Image 

When you accept a rejected image, the Send Image to Output dialog box displays. Select 
Yes to send the images to the selected output group.  

 
Note If you select the No button, you can resend the images with 

the Image/Spool Management function. 
 

 
 

How to Reject an Accepted Image 
To reject an Accepted Image: 

1. In the Patient View screen, select the Review button. 
2. In the dialog box, select the tab for the View to reject.  
3. Select the Accepted Image. 

 
Figure 80: Set Rejected Button 

4. Select the Set Rejected button.   
5. Select a reason for the reject. See the figure The Reject Reasons List on page 96. 
6. Select the Reject button. 
7. Select the OK button. The displayed thumbnail image disappears from the Patient 

View screen. 
 

 
Note After you reject an Image with this method, the image is not 

removed from the output queues. To delete the image from 
the queues, see the table in Manage Queues on page 71. The 
Rejected Image is added to the Reject Analysis Bin for 
tracking purposes. 
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6.5 A Screening Exam Sequence Suggestion 
Table 14: Workflow Suggestions to Select a Patient and Acquire an Image 

Action What it looks like 

1. Start up the system and log in to Operating 
System and Application. See Procedure for 
Startup on page 31. 

 

 
Figure Legend 

1. Power On button 

2. Power On indicator light 

2. Select the Procedure, when more than one is 
scheduled. 
 
Select from the scheduled procedures list 

a. Find the procedure in the list. 

b. Click the Select button. 

 
Add a procedure 

a. Select New in the Procedure area. 

b. Select the procedure from the list. 

c. Select the Accept button. 

 

3. Edit the Patient Information, if necessary. To 
edit: 

a. Select the patient from the patient list. 

b. Select Edit from the Patient area. 

c. Make the changes in the Edit Patient 
screen. 

d. Select the Accept button.  

4. Install the accessories. See The Selenia 
Accessories on page 41 for installation, 
removal, and alignment procedures for each 
device. 

• Face Shield 
• Compression Paddle 
• Magnification Platform 
• Crosshair 

 



Selenia User Guide 
Chapter 6: The User Interface 
 
 

 
Page 100 MAN-10980 Revision 001 

Table 14: Workflow Suggestions to Select a Patient and Acquire an Image 

Action What it looks like 

5. Select the view: 

a. Click Add View in the Patient View 
screen.   

b. In the dialog box, select a view from the 
list of Standard Mammography Views. 
To add multiple views, press and hold 
the Control key and select the views. 

c. Select the OK button. 
 

 
 

6. Select the Exposure Techniques. 
 

 
7. Position the system and patient. 

a. Adjust the vertical height of the Breast 
Platform. 

b. Set the C-arm angle. 

c. Put the arm and hand of the patient in a 
safe location. 

d. Compress the breast. 
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Table 14: Workflow Suggestions to Select a Patient and Acquire an Image 

Action What it looks like 

8. Acquire the image: 

a. Make sure that the message area of the 
screen displays "Ready" (see item 1 in the 
following figure) and there is no "X" 
through the x-ray indicator (see item 2). 

b. Press and hold the x-ray buttons. 

c. Inspect the image on the Preview Screen, 
then select the Accept or Reject button.  

 
9. Close the procedure: 

a. Select the Close Procedure button. 

b. Select the Yes button. 
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7: Maintenance and Cleaning 
7.1 General Information About Cleaning 

Before each examination, clean and use a disinfectant on any part of the system which 
touches a patient. Give the attention to the paddles and the image receptor. 

 
Caution: Do not use any hot source (like a heating pad) on the 

image receptor. 
 

Be careful with the compression paddles. Inspect the paddles. Replace the paddle when 
you see damage. 

7.1.1 For General Cleaning 
Use a lint-free cloth or pad and apply a diluted dishwashing liquid. 

 
Caution: Use the least possible amount of cleaning fluids. The 

fluids must not flow or run. 
 

   

If more than soap and water is required, Hologic recommends any one of the following: 

• 10% chlorine bleach and water with one part commercially available chlorine bleach 
(normally 5.25% chlorine and 94.75% water) and nine parts water 

• Commercially available isopropyl alcohol solution (70% isopropyl alcohol by 
volume, not diluted) 

• 3% maximum concentration of hydrogen peroxide solution 
After you apply any of the above solutions, use a pad and apply a diluted dishwashing 
liquid to clean any parts which touch the patient. 

 

 Warning: If a paddle touches possible infectious materials, 
contact your Infection Control Representative to 
remove contamination from the paddle. 

 

  
 

 
Caution: To prevent damage to the electronic components, do not 

use disinfectant sprays on the system. 
 

 
 

Chapter 7:  
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7.1.2 To Prevent Possible Injury or Equipment Damage 
Do not use a corrosive solvent, abrasive detergent, or polish. Select a 
cleaning/disinfecting agent that does not damage the plastics, aluminum, or carbon fiber. 

Do not use strong detergents, abrasive cleaners, high alcohol concentration, or methanol 
at any concentration.  

Do not expose equipment parts to steam or high temperature sterilization. 

Do not let liquids enter the internal parts of the equipment. Do not apply cleaning sprays 
or liquids to the equipment. Always use a clean cloth and apply the spray or liquid to the 
cloth. If liquid enters the system, disconnect the electrical supply and examine the system 
before returning it to use. 

 
Caution: Wrong cleaning methods can damage the equipment, 

decrease imaging performance, or increase the risk of 
electric shock. 

 

Always follow instructions from the manufacturer of the product you use for cleaning. 
The instructions include the directions and precautions for the application and contact 
time, storage, wash requirements, protective clothing, shelf life, and disposal. Follow the 
instructions and use the product in the most safe and effective method. 

7.2 Care and Cleaning—Acquisition Workstation and Value 
Console 

7.2.1 How to Clean the Preview Display 
Avoid touching the display screen. 

Use care when cleaning the outer surface of the LCD screen. Always use a clean, soft, 
lint-free cloth to clean the display area. Microfiber cloths are recommended. 

• Never use a spray or flow a liquid on the display. 
• Never apply any pressure to the display area. 
• Never use a detergent with fluorides, ammonia, alcohol, or abrasives. 
• Never use any bleach. 
• Never use any steel wool. 
• Never use a sponge with abrasives. 
There are many commercially available products to clean LCD displays. Any of the 
products free of the ingredients described above and used according to the directions of 
the manufacturer can be used. 

7.2.2 How to Clean the Keyboard 
Wipe the surfaces with a CRT wipe. If necessary, clean the keyboard with a vacuum. If 
liquids enter the keyboard, contact Technical Support for a replacement. 
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7.3 Preventive Maintenance 
 

Table 15: User Preventive Maintenance 

 Recommended Frequency 

Maintenance Task  
Description 

Each Use Daily Weekly 
Bi- 

weekly 
Monthly Quarterly 

Semi- 
annually 

Clean & disinfect paddle x       
Clean & disinfect breast 
platform 

x       

Visually inspect all paddles for 
damage 

x       

Recommended/ required start 
of operation verifications 

 x   x   

All daily recommended/ 
required calibration 

 x     x 

Diagnostic Review Workstation 
Quality Control * 

  x     

Detector Flat Field Calibration *   x     
Artifact Evaluation *   x     
Phantom Image *   x     
Signal to Noise / Contrast to 
Noise Measurements * 

  x     

Compression Thickness 
Indicator * 

   x    

DICOM Printer Quality Control   x     
View boxes and Viewing 
Conditions 

  x  x   

Repeat/Reject Analysis*      x  
Compression *       x 
Visual Checklist *     x   
Emergency Stops     x   
Clean array dust filter     x   

* Refer to Quality Control Manual 
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Appendix A   System Specifications 
A.1  Dimensional Information 

A.1.1  Tubestand (Gantry with C-arm) 

 
Figure 81: Tubestand Dimensions 

A. Height with C-arm Travel 213.0 cm (84.07 inches) ±1.0 cm (0.4 inches) at highest C-arm 
travel 

B. Height 190.0 cm (74.8 inches) 
C. Width 65.0 cm (25.6 inches) ±1.0 cm (0.4 inches) (C-arm at 0° 

position) 
D Depth 110.0 cm (43.3 inches)±1.0 cm (0.4 inches) 
 Weight 300 kg (661 lb.) ±20 kg with Image Receptor 

 

 
 

A.1.2  Acquisition Workstation 

 
Figure 82: Acquisition Workstation Dimensions 

A Height 189.5 cm (74.6 inches) (maximum) 

B Width 107 cm (42.1 inches) 
C Depth 76 cm (30.0 inches) 
D Swivel Arm Radius 60.5 cm (23.81 inches) 
 Weight 120 kg (264.5 lb.) (maximum) 

 

 
 

Appendix A:  
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A.1.3  Selenia Value Console 

 
Figure 83: Value Console Dimensions 

A Height 191.3 cm (75.3 inches) 
B Width 101.2 cm (39.8 inches) 
C Depth 60.5 cm (23.8 inches) 

 Weight 163.3 kg (360 lb.) (maximum) 
 

 
 

A.2  Operating Environment 

A.2.1  General Operating Conditions 
Temperature Range 20 °C (68° F) to 30 °C (86° F) 
Maximum rate of temperature change <10 ºC/hr 
Relative Humidity Range 10% to 80% non-condensing 
BTU output Typical Range 1700–2500 BTU/hr 

 

 
 

A.3  Storage Environment 

A.3.1  Tubestand 
Temperature Range -25 °C (-13° F) to +60 °C (140° F) 
Humidity Zero to 95% humidity—non-condensing (not packaged 

for outdoor storage) 
 

 
 

A.3.2  Image Receptor 
Storage Temperature Range 10 ºC (50° F) to 40 ºC (104° F) 
Maximum rate of temperature change <15 ºC/hr 
Storage Humidity Range 10% to 80% humidity— non-condensing (not packaged 

for outdoor storage) 
 

 
 



Selenia User Guide 
Appendix A: System Specifications 

 
 

 
MAN-10980 Revision 001 Page 109 

A.4  Electrical Input 

A.4.1  Tubestand 
Mains Voltage 200/208/220/230/240 VAC nominal, true sinusoidal,  

(tap selectable at installation) ±10%, Single Phase,  
50/60 Hz ± 5%, permanently wired 

Mains Impedance Maximum line impedance not to exceed 0.20 ohms for 
220/230/240 VAC, 0.16 ohms for 200/208 VAC 

Maximum Power Consumption 6.5 kVA for 5 second duration 
Standby Current 4.0 A (maximum) 
Maximum Line Current 35 A for 5 seconds [momentary rating per NEC 70 Article 517 

(2014 Edition)] 
Recommended Branch Circuit Breaker 
Rating 

25 A minimum, refer to NEC 70 Article 517 (2014 Edition) 

 

 
 

A.4.2  Acquisition Workstation 
Input Line Voltage 100/120/200/208/220/230/240 VAC nominal, true sinusoidal, 

(tap selectable at installation), ± 10% 
Input Current 8.0 A maximum @ 100/120 VAC 

3.5 A maximum @ 200/208/220/230/240 VAC 
Frequency 50/60 Hz ±5% 
Number of Phases Single 

 

 
 

A.5  Acquisition Workstation Technical Information 
Computer Memory 2 GB RAM minimum 
Disk capacity > 60 GB Image Storage 
Storage Media CD-RW Disks 
Display Adapter Card 1600 x 1200 matrix minimum 8 bit gray scale display 
Display 1600 x 1200 matrix minimum 450 cd/m2 nominal brightness 

Network Interface 10/100 Base-T Ethernet 
Remote Diagnostics Internet 
Graphical User Interface X-ray exposure control 

Configurable mammographic Workflow 
Patient demographics 
Brightness and contrast control 
Magnification screen 
Pixel value readout 
QC test tools  
System Status Monitoring 
Error reporting 
Unattended archiving and printing 

Radiation Shield Pb equivalence Rated for a 0.5 mm Pb (lead) equivalence 
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A.6  Tubestand Technical Information 

A.6.1  C-arm 
Motorized C-arm Rotation Speed Variable speed (18° per second maximum). Rotation speed is 

service selectable: 50% to 100% in 5% increments. Motor 
Control provides soft start and dynamic braking. 

C-arm Rotation Range +195° +2° /-0° to 0° ±0.5° to -150° +0° /-2° (detent at 0°, 
±90°). Rotation angle is displayed on both sides of Gantry. 

Vertical Travel 74.5 cm (29.5 inches) total travel. 
Source-to-Image Distance (SID) 66.0 cm (26.0 inches) ± 1.0 cm (0.4 inches) 
Source-to-Image Receptor Support Device 
Distance 

64.0 cm (25.2 inches) ± 1.0 cm (0.4 inches) 

Magnification Ratio 1.8 x for objects 22.5 mm above the magnification platform 
breast support surface 

 

 
 

A.6.2  Compression 
Manual Compression Force Limited to a maximum of 300 N +0/-89 N (67.4 lb. +0/-20 lb.) 

from 0° to +/-90° C-arm rotation. Not less than 169 N (38 lb.) for 
a C-arm angle range greater than +150° and an angle less 
than -150°. 

Motorized Compression Functions in three operating modes, Pre-compression, Full-
Range, Dual Compression, user selectable through software. 

 Pre-Compression Force 67 N +0/-22.3 N to 133.5 N ±22.3 N (15 lb. +0/-5 lb. to 30 lb. ±5 
lb.) 

 Full-Range Compression Force 89 N ±22.3 N to 178 N ±22.3 N (20 lb. ± 5.0 lb. to 40.0 lb. ± 5.0 
lb.) 

 Dual Mode Compression Provides Pre-Compression force upon first activation of 
compression switch; then, if switch is activated within 2 seconds, 
the force is increased incrementally for each additional switch 
activation, up to the user selected FULL compression force. 

Compression Controls Up/Down controls on both sides of C-arm and on 2-position 
footswitch (Motorized). Handwheel on both sides of Compression 
Device (Manual). 

Compression Release Manual or Automatic. Motorized Release mode controlled by 
push-buttons on both sides of the C-arm. User selectable 
automatic release mode raises Compression Device upon exposure 
termination. All release functions are disabled if a Localization 
paddle is detected. 

Automatic Compression Release  Moves the compression device upward a predetermined distance 
(10 cm). For Magnification Mode this may be less. 
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Compression Down Motion Variable 
Speed 

Service Selectable between approximately 10% through 100% of 
full speed. 

Compression Force Display Two LED Displays on the Compression Device show the 
compression force through the range of 10 lb. to 67.4 lb. (44.5 N 
to 300 N) in 1 lb. (4.4 N) increments. 

Compression Force Display Accuracy ±4.5 lb. (±20 N) 

Compression Thickness Display Two LED Displays on Compression Device measures between 0 
and 15 cm above image receptor in 0.1 cm increments. The 
display is visible from both sides of the patient. 

Compression Thickness Accuracy ±0.5 cm for thicknesses between 0.5 cm and 15 cm 
Compression Paddles Compression paddles are transparent. The paddles are composed 

of polycarbonate. The paddles provide a parallel plane to the 
image receptor and do not deflect by more than 1 cm difference 
from any surface providing compression under 25 lb. (111.1 N) of 
compression force (except for F.A.S.T. paddles.). The paddles are 
adjustable to provide the focal spot, compression device and image 
receptor alignment requirement. 

 

 
 

A.6.3  X-ray Tube: Molybdenum 
Focal Spot (NEMA / IEC) Large (0.3 mm) Nominal 

Small (0.1 mm) Nominal 
Tube Voltage 20 kV to 39 kV 
Tube Current Large Focal Spot = 100 mA between 25 and 32 kV  

Small Focal Spot = 30 mA between 25 and 32 kV 
Anode Rotation 180 Hz (9600 RPM minimum) 
Anode Angle Bi-angular: Large focal spot at 16°, Small focal spot at 10°. X-

ray tube angle at 6° to provide 22° (Large FS) and 16° (Small 
FS) anode to Image Receptor plane angle. 

Anode Material Molybdenum 
X-ray Window Beryllium 0.8 mm thickness (maximum) 

 

 
 

X-ray Tube Housing 
Over Temperature Protection Sensor Internally connected in series with the stator common lead. 

Maximum Temperature, Tube Housing 
Surface 

55 °C (151° F) 

Maximum Temperature, Tube Head Cover 
Surface 

41 °C (105.8° F) 

Safety Class IEC 60601-1, Class I,IEC 60601-2-28 
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X-ray Beam Filtration and Output 
Inherent Tube Filtration 0.0 mm Al equivalent 
Added Filtration Two-position filter changer mechanism to carry a 30-micron 

(0.03 mm) Molybdenum foil filter and a 30-micron (0.03 mm) 
Rhodium foil Filter. Type of filter is user selectable. 

Beam Quality HVL for Mo/Mo Operation At a given kilovolts, the measured HVL with the compression 
paddle in the x-ray beam is equal to or greater than the value 
of kV/100+0.03 (in units of mm of aluminum) but less than the 
value of kV/100+0.12 (in units of mm of aluminum). 

Beam Quality HVL for Mo/Rh operation At a given kilovolts, the measured HVL with the compression 
paddle in the x-ray beam is equal to or greater than the value 
of kV/100+0.03 mm Al (in units of mm of aluminum) but less 
than the value of kV/100+0.19 mm Al (in units of mm of 
aluminum). 

Radiation Output Equal to or greater than 800 mR/second for at least 3 seconds. 
Output is measured through the Compression Paddle, 4.5 cm 
above the breast support, 4.0 cm from the chest wall edge, 
using exposure techniques of Mo/Mo target/filter, large focal 
spot, 28 kV. 

 

 
 

A.6.4  X-ray Tube: Tungsten 
Tube Voltage 22 kV to 39 kV 
Tube Current Large Focal Spot = 100 mA between 25 and 32 kV  

Small Focal Spot = 30 mA between 25 and 32 kV 
Anode Rotation 180 Hz (9500 RPM minimum) 
Anode Angle Bi-angular: Large focal spot at 16°, Small focal spot at 10°. 

X-ray tube angle at 6° to provide 22° (Large FS) and 16° 
(Small FS) anode to Image Receptor plane angle. 

Anode Material Tungsten 
X-ray Window Beryllium 0.8 mm thickness (maximum) 

 

 
 

X-ray Tube Housing 
Over Temperature Protection Sensor Internally connected in series with the stator common lead. 

Maximum Temperature, Tube Housing 
Surface 

55 °C (151° F) 

Maximum Temperature, Tube Head Cover 
Surface 

41 °C (105.8° F) 

Safety Class IEC 60601-1, Class I, Type B, IEC 60601-2-28 
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X-ray Beam Filtration and Output 
Inherent Tube Filtration 0.0 mm Al equivalent 
Added Filtration Two-position filter changer mechanism to carry a 60-micron 

(0.06 mm) Rhodium foil filter and a 60-micron (0.06 mm) Silver 
foil Filter. Type of filter is user selectable. 

Beam Quality HVL for W/Rh Operation At a given kilovolts, the measured HVL with the compression 
paddle in the x-ray beam is less than the value of kV/100 +0.03 
(in units of mm of aluminum). 

Beam Quality HVL for W/Ag operation At a given kilovolts, the measured HVL with the compression 
paddle in the x-ray beam is less than the value of kV/100 +0.03 
(in units of mm of aluminum). 

Radiation Output Equal to or greater than 230 mR/second for at least 3 seconds. 
Output is measured through the Compression Paddle, 4.5 cm 
above the breast support, 4.0 cm from the chest wall edge, using 
exposure techniques of W/Rh target/filter, large focal spot, 28 
kV. 

 

 
 

A.6.5  X-ray Collimation 
Available Collimated X-ray Fields: 

Table 16: Collimation Settings 
Predefined Collimation Settings 

24 x 29 cm 
18 x 24 cm 
15 x 15 cm 
10 x 10 cm 
7.0 x 8.5 cm 

 

 
 

A.6.6  Light Field Indication 
Light Field Lamp Illuminates for 30 seconds, ±5 seconds, upon pressing a Light 

Field switch on either side of the x-ray tubehead or by pressing 
a Compression Down switch. Extinguishes automatically 
upon exposure initiation. A shatter shield is provided. 

Light Field Illuminance 160 lux (minimum)—meets 21 CFR 1020.31 requirements. 
Lamp is adjustable to provide alignment of the light field to the 
x-ray field. 

Light Field-to-X-ray Field Congruency Within 2% of SID 
Ripple 2% or less (typical), maximum 4% 
Topology Pulse width modulated High Frequency, active servo 

controlled 
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kV /mA Range 
Table 17: LFS mA setting as a function of kV 

Large Focal Spot 
kV mA 

20* 75 mA 
21* 80 mA 
22 85 mA 
23 90 mA 
24 95 mA 
25-32 100 mA 
33 85 mA 
34-35 80 mA 
36-37 75 mA 
38-39 70 mA 
*Molybdenum Tubes only 

 

Table 18: SFS mA setting as a function of kV 
Small Focal Spot 

kV mA 
20 20 mA 
21 22 mA 
22 24 mA 
23 26 mA 
24 28 mA 
25-32 30 mA 
33-34 28 mA 
35-37 26 mA 
38-39 24 mA 

 
 

 
Note All values are for mAs values > 40 mAs. For mAs values < 

40 mAs, the mA value adjusts by the mA Factor listed in the 
following table as a function of mAs. 

 
 

Table 19: mA Factor as a function of mAs 
mAs mA Factor 

4-6 10% 
8-10 20% 
12-22 30% 
24-38 60% 
>40 100% 
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Large Focal Spot Manual mAs Range:  

TABLE 1 (default): 3 mAs through 400 mAs, 22 steps: 3, 4, 5, 6.4, 8, 10, 
12.5, 16, 20, 25, 32, 40, 50, 64, 80, 100, 125, 160, 200, 
250, 320, 400. 

 

 
Note Lower limit is 4 mAs when grid is in field. 

 

TABLE 2 (user selected): 3 mAs through 400 mAs, 55 steps: 3, 4, 5, 6, 7, 8, 9, 
10, 12, 14, 16, 18, 20, 22, 24, 26, 28, 30, 32.5, 35, 37.5, 
40, 42.5, 45, 47.5, 50, 55, 60, 65, 70, 75, 80, 85, 90, 95, 
100, 110, 120, 130, 140, 150, 160, 170, 180, 190, 200, 
220, 240, 260, 280, 300, 325, 350, 375, 400. 

 
 

 
Note Lower limit is 4 mAs when grid is in field. 

 
 

 
Note In AEC modes, in Large Focal spot, the mA setting adjusts 

downward, if necessary, to achieve the calculated mAs. mA 
can be adjusted as low as 10 mA. 

 

Small Focal Spot Mag Manual mAs Range: 

TABLE 1: 3 mAs through 100 mAs, 16 steps: 3, 4, 5, 6.4, 8, 10, 
12.5, 16, 20, 25, 32, 40, 50, 64, 80, 100 

TABLE 2: 3 mAs through 120 mAs, 38 steps: 3, 4, 5, 6, 7, 8, 9, 
10, 12, 14, 16, 18, 20, 22, 24, 26, 28, 30, 32.5, 35, 37.5, 
40, 42.5, 45, 47.5, 50, 55, 60, 65, 70, 75, 80, 85, 90, 95, 
100, 110, 120 

 

 
 

Accuracy, Reproducibility, and Linearity 
Reproducibility < 0.05 coefficient of variation for 10 consecutive exposures (21 

CFR). 
Linearity < 0.10 for adjacent mAs selections per the following: 

 (X1-X2) is less than or equal to 0.10 (X1+X2) where X1 and 
X2 are average mR/mAs values for consecutive exposures (21 
CFR). 

mAs Accuracy ±5% or ±2 mAs, whichever is greater, from indicated, 
measured from the ground side of the tube circuit. 

kV Accuracy Within 1 kV of the indicated kV 
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A.7  Imaging System Technical Information 

A.7.1  Image Receptor 
Fluid ingress No fluid from incidental spillage on the top surface of the 

Image Receptor seeps inside 
Deflection Does not exceed 1.0 mm at maximum compression 
Active Imaging Area 24 cm x 29 cm Nominal. The active image area is marked on 

the digital image receptor/breast platform cover. 

Image Size, Screening and Diagnostic 
Exams 

18 x 24 cm nominal; locations: center, left, right 24 x 29 cm 
nominal; center location only 

Image Size, Diagnostic-Spot Compression 18 x 24 cm nominal; locations: center, left, right 
Image Size, Diagnostic-Magnification 18 x 24 cm nominal; center location only 
Image Pixel Size 70 µm 
Digital Image Receptor MTF -Nyquist 
frequency 

> 0.40 

DQE at 0 c/mm 50% or greater at 7.0 mR -0.0/+0.7 mR x-ray exposure 
DQE at Nyquist frequency 15% or greater at 7 mR -0.0/+0.7 mR x-ray exposure 
Saturation X-ray exposure level at which image pixels are saturated is not 

less than 1000 mR 
Dynamic Range Linear response over at least 400:1 in x-ray exposure 
Output Image 14 bit image data 
Scatter Rejection Lorad HTC™ high transmission cellular grid 
Chest Wall Access The distance from the outside edge of the Image Receptor 

enclosure to the Active Image Area along the chest wall is less 
than 5 mm. 

Lateral Wall Access The distance from the outside edge of the detector enclosure to 
the active detector area along the edges perpendicular to the 
chest wall is less than 40 mm. 

ACR Phantom Score at MGD = 2mGy At least 5 fibers, 4 specks, 4 mass 

Image Preview Time The time between completion of an x-ray exposure and 
availability of the Preview image: less than 20 seconds. 

Transmission Limit Within Federal Regulatory limit for screen-film 
mammography systems (21CFR 1020): 0.1 mR/h. 
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A.8  Tissue Exposure Control (TEC) Mode 
The Breast Density Default Setting Selectable via the Generator default screen on the Acquisition 

Workstation. Breast density defaults to the default setting at 
the beginning of each new study and when the exposure mode 
is first changed to TEC. 

Breast Density Panel Update rate once every 2 seconds maximum 
Mammography Unit Status Polling Between image capture cycles, Acquisition Workstation 

requests and displays current technique at a rate not slower 
than once every 2 seconds. In TEC mode, the rate increases to 
no slower than once per second, but not faster than once per 
0.75 seconds. System response time for a single Generator 
Technique command is 1 second or less. 
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A.9  Automatic Exposure Control (AEC) 
AEC Sensor Positionable in seven locations, centered laterally in the image receptor 

support device. Position #1 is located 1 cm from the chest wall. Positions are 
spaced in 1.7 cm increments. 
The AEC region can be selected automatically by processing the pre-exposure 
image data to find the corresponding dense portion of the breast. 
When the AEC region auto-selection is enabled, the detector area that is 
scanned is dependent on the default x-ray collimation that is linked to the 
compression paddle ID. Change of collimation by the operator is ignored for 
AEC region auto-selection. 
LEDs for each AEC sensor position on the compression gantry indicate the 
selected position. The selected AEC region can be viewed after selecting the 
check box.  
The size and available position of the manual AEC regions are indicated at the 
x-ray input surface of the compression paddle. 

AEC Auto-Filter Mode The filter and kV are selected using the recommended table based exposure 
technique based on compressed breast thickness.  
The exposure is terminated at an mAs value as determined by the AEC system 
to yield a pixel count to which the unit has been calibrated. 

AEC Auto-kV Mode The Filter is not selectable. The filter defaults to Mo if the system is configured 
with Moly Tube. The filter defaults to Rh if the system is configured with a 
Tungsten Tube. Starting kV is determined by the Gantry. mAs is determined 
by the Digital Detector. 

AEC Auto-Time Mode The kV and filter are both user selectable. 
The exposure is terminated at a mAs value as determined by the AEC system 
to yield a pixel count to which the unit has been calibrated. 

Exposure Termination An exposure is aborted or prevented if: 
The predicted exposure time exceeds the x-ray tube limits. The predicted 
exposure time exceeds the safety backup timer setting. 
The predicted exposure time is less than 400 msec when the grid is in the x-ray 
field or less than 30 msec when the grid is out of the x-ray field. 
The user releases the exposure button prematurely. 
There is an error within the Selenia FFDM system. 

AEC Reproducibility AEC exposure reproducibility meets MQSA requirements as follows: 
For a 4 cm thick average breast phantom, coefficients of variation in mAs and 
digital values shall be less than 0.05 for four consecutive exposures of this 
phantom under each of the three AEC modes. 

Exposure Adjustment There is a "user-adjustable" scale factor that can be used to increase/decrease 
the final x-ray exposure (mAs) by 15% for each step from the default setting. 
A total of eight settings are available on the Acquisition Workstation, which 
allows the user to change the exposure from -55% of the default value to 160% 
of the default value. 

 
 
 
 
 

 
Note AEC exposure adjustment is not available in all geographic 

regions. 
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A.10  Hardcopy Film Printing Devices 
This section lists the relevant technical characteristics for the hardcopy film printing 
device. 

A.10.1  Image Engine 
Film sizes 20 cm x 25 cm (8 inches x 10 inches) 

25 cm x 30 cm (10 inches x 12 inches), optional 
Pixel size <70 µm 
Grey level resolution >8 bits 
Maximum Film Optical Density >3.5 

 

 
 

A.10.2  Interface 
Connectivity DICOM 3.0 compatible 
Data port Ethernet 
Transfer rate Minimum: 10 Mbits/sec 
Look up Tables (LUT) Field programmable; Linear 

 

 
 

A.10.3  Printed Film 
Print to fit If a 24 x 29 cm image is printed on a 20 x 25 cm (8 x 10 

inches) film, the printer prints the image to fit onto a 20 x 25 
cm (8 x 10 inches) film without cropping the image or without 
dropping rows and columns of data 

Patient Information Film meets ACR/MQSA requirements for patient 
demographics. Printed Information Is User Configurable. 
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Appendix B   The Mobile Selenia 
This appendix provides information about Selenia systems installed in a mobile 
environment. 

B.1  General Information 

B.1.1  The Vertical Position Override Switch (VPOS) 
The Mobile Selenia has a Vertical Position Override Switch (VPOS) on the back of the 
Gantry. This switch can start the Selenia if the C-arm is lower than its normal operating 
position after rough-road travel. 

 
Figure 84: Location of Vertical Position Override Switch (VPOS) 

 

 
 

Background 
Switches located in the Gantry limit the C-arm vertical travel to a pre-defined range. 
When the C-arm reaches its highest or lowest point of normal travel, the switches engage 
to stop further motion. If the C-arm should travel past the Limit switches (in the event of 
switch failure or other electrical malfunction), a second switch engages that removes 
power from the system. A Field Engineer would normally be contacted to repair and 
restart the Selenia. 

In a mobile environment (during transport), it is possible for the C-arm to 'creep' 
downward and beyond the two Limit switches. If this occurs, the Selenia would be 
disabled—the lower limit switch would engage, preventing the system from normal 
start-up. This is not a failure condition that would require a Field Engineer's attention. 
The Vertical Position Override Switch is used to allow the operator to start the system 
and raise the C-arm to within its normal working limits. 

Appendix B:  
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When to Use the VPOS 
This condition shows on the first startup after transport. The Acquisition Workstation 
starts normally, but the Gantry does not startup. After Logon, an alert message appears 
that communication to the Generator is lost. 

How to Use the Vertical Position Override Switch to Restart the Gantry 
1. Press and hold the Vertical Position Override Switch—the Gantry starts. Continue to 

hold the switch pressed. 
2. After approximately 5 seconds, lift the C-arm approximately 7.5 cm (3 inches) with 

the normal system controls. Release the VPOS after you lift the C-arm. 
3. At the Acquisition Workstation, accept the prompt to restart the Generator. The 

Gantry turns off for a few seconds, then automatically restarts. 
4. The system is ready for normal use. 

 

B.2  Safety Conditions and Other Precautions 
 

 Warning: The radiation shield is not approved for mobile use 
and is not provided. The coach manufacturer must 
provide adequate shielding. 

 

 
 

 

 
Caution: When shore power is unavailable, mobile power sources 

that provide equivalent performance may be employed. 
(see Mobile Specifications.) Proper system function and 
performance can only be ensured if continuous true 
sinusoidal VAC power is supplied per the system power 
input specifications and loading characteristics. 
Intermittently, the power source must provide 65 Amps at 
208 VAC for minimum of 5 seconds, and 4 Amps 
maximum continuous otherwise. This load must be 
supported once every 30 seconds. In the event of shore or 
mobile power service interruption, the UPS must be 
capable of providing the operational power described 
above for a minimum of 4 minutes. Acquisition 
Workstation and Gantry power must be fed on separate 
dedicated circuits. The use of an uninterruptible power 
supply with active line conditioner is recommended on 
each power circuit. Accordingly, all ancillary mobile coach 
power should be distributed by other circuits. The 
electrical installation must be verified to meet system 
power input specifications and IEC 60601-1 safety 
requirements after initial installation and upon each 
relocation of the mobile coach. 
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Caution: The temperature and humidity inside the vehicle must be 

maintained at all times. Do not allow environmental 
conditions to exceed stated specifications when the unit is 
not in use. 

 
 

 
Caution: For permanent archive, the Selenia must be attached to a 

PACS system or connected to a suitable hard-copy printer 
when in use. 

 
 

B.3  Mobile Specifications 

B.3.1  Shock and Vibration Limits 
Vibration Limit Not greater than 0.35 G (2 Hz to 200 Hz), as measured at 

mounting point of system to coach. 
Shock Limit Not greater than 1.0 G (½ sine pulse), as measured at 

mounting point of system to coach. An "air ride" coach 
suspension is recommended. 

 

 
 

B.3.2  Coach Environment 

Operating Environment 
Temperature Range 20 °C (68° F) to 30 °C (86° F) 
Maximum Rate of Temperature Change <10 ºC/hr 
Relative Humidity Range 10% to 80% non-condensing 
BTU output Typical Range 1700–2500 BTU/hr 

 

 
 

Non-operating/Transit Environment 
Temperature Range 15 °C (59° F) through 35 °C (95° F) 

Maximum Rate of Temperature Change <15 °C/hr 
Relative Humidity Range 10% to 80% non-condensing 
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B.3.3  Electrical Input 

Tubestand 
Mains Voltage 200/208/220/230/240 VAC nominal, true sinusoidal,  

(tap selectable at installation) ±10%, Single Phase,  
50/60 Hz ± 5%, permanently wired 

Mains Impedance Maximum line impedance not to exceed 0.20 ohms for 
220/230/240 VAC, 0.16 ohms for 200/208 VAC 

Maximum Power Consumption 6.5 kVA for 5 second duration 
Standby Current 4.0 A (maximum) 
Maximum Line Current 35 A for 5 seconds [momentary rating per NEC 70 Article 517 

(2014 Edition)] 
Recommended Branch Circuit Breaker 
Rating 

25 A minimum, refer to NEC 70 Article 517 (2014 Edition) 

 

 
 

Acquisition Workstation 
Input Line Voltage 100/120/200/208/220/230/240 VAC nominal, true sinusoidal, 

(tap selectable at installation), ± 10% 
Input Current 8.0 A maximum @ 100/120 VAC 

3.5 A maximum @ 200/208/220/230/240 VAC 
Frequency 50/60 Hz ±5% 
Number of Phases Single 

 

 
 

B.4  How to Prepare the System for Transport 
Perform these steps before you transport the Mobile System: 

1. Rotate the C-arm to 0 degrees (CC position). 
2. Lower the C-arm to its lowest position. 
3. Remove all power from the system. 
4. Remove all system accessories (like the Face Shield, and Compression Paddles) 

before transport. Store all accessories correctly to make sure the components are not 
damaged. 
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B.5  How to Test the System Integrity After Transport 
Instructions: Photocopy this checklist for use after the system is relocated. 

Name_____________________________________   Date_______________ 

System Serial Number____________________________________ 

Table 20: Integrity Checklist 
Evaluated Control Functions Reference 

Mechanical System Tests 

 Compression Up/Down Controls and Functional Tests on page 33 

 Compression Release Controls and Functional Tests on page 33 

 C-arm Rotation Controls and Functional Tests on page 33 

 C-arm Up/down Controls and Functional Tests on page 33 

 Collimator Override Controls and Functional Tests on page 33 

 Light Field Lamp Controls and Functional Tests on page 33 

 Smart Paddle System Controls and Functional Tests on page 33 

 Emergency Off Switches Emergency Off Switches on page 23 

Quality Control Tests 

 Artifact Evaluation Selenia QC Manual 

 SNR/CNR Measurement Selenia QC Manual 

 Phantom Image 
Evaluation 

Selenia QC Manual 

 Compression Thickness Selenia QC Manual 
 

 
 





Selenia User Guide 
Index 

 
 

 
MAN-10980 Revision 001 Page 127 

Index 
A 
accept 

rejected image • 97 
Accept button • 96, 99 
accessories 

compression paddles • 42 
Smart Paddles • 33, 43 

magnification platform • 47 
acquire images • 82, 99 
Acquisition Workstation 

circuit breaker location and function • 22 
add 

additional view to procedure • 81, 99 
new entry with function key • 26 
new patient • 54 
user • 67 

AEC 
region, display on preview screen • 94 
select Exposure Mode with keyboard • 26 
sensor position • 26, 29, 30 

alarms • 79 
annotation tools list • 85 
archive, commit to storage function enabled • 70 
AUTO AEC sensor 

display region used • 94 
average glandular organ dose display • 95 
avoid injury or equipment damage • 104 

B 
bar code scanner • 9, 26 
breast density • 26 
button 

compression release • 25 
Eject, on CD-RW drive • 73 
on and x-ray • 25 

button (software) 
Accept • 54, 56 
Add View • 81, 99 
Brightness/Contrast (Window/Level) • 93 
Cancel/Clear • 54, 56 
Clean Up • 76 
Clear All Markers • 87 

Comments • 86 
Crosshairs • 90 
Edit View • 87 
Full Zoom/Pan • 88 
Implant Present • 88 
Import Priors • 75 
Magnification button • 92 
Measurement • 91 
New Patient • 54 
Query Retrieve Priors • 75 
Quick Zoom/Pan • 88 
Reject • 97 
Remove Unexposed Views • 81 
Resend • 74 
Resend Stopped Job • 71 
Retrieve and Import • 75 
Review • 97 
ROI (Region of Interest) • 89 
Set Accepted • 97 
Set Rejected • 98 
Window/Level (Brightness/Contrast) • 93 

C 
calibration messages • 76 
care and cleaning • 104 
C-arm 

controls and displays • 28, 29 
Gantry rotation switches • 28 
rotation switches • 29, 33 
up and down • 33 

CD, CD-RW 
available space on • 77 
ejecting disks • 72 
importing images from • 73 

CD-RW Drive 
Eject button • 73 

circuit breaker • 9 
Gantry • 22, 28 

Clean Up button • 76 
Clear All Markers button • 87 
close 

Exam (Procedure) key • 26 
procedure • 81, 99 

collimator 
automatically set to paddle size • 65 
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override • 33 
Comments 

button • 97 
entering or modifying • 86 

commit function, archive • 70 
complaints, product • 2 
compliance • 14, 15 

label locations • 17 
compression 

automatic release • 110 
controls and displays • 30 
down/up • 33 
force display accuracy • 110 
functional tests • 33 
release buttons • 25 
thickness 

display • 30 
display accuracy • 110 

compression paddles 
cleaning • 42 
FAST paddles • 43 
installing and removing • 42 

contrast, change for printer • 75 
controls • 22, 30 

AEC sensor position • 30 
automatic compression release • 33, 110 
C-arm • 29, 30, 33 
C-arm rotation • 29, 33 
collimator override • 29, 33 
compression • 29, 30, 33 
compression release buttons • 25 
handwheels • 30 
light field lamp • 29, 33 
location and appearance • 33 
manual compression • 29 

Crosshair device • 90 
aligning to localization paddle • 49 
installing and removing • 48 

D 
defaults 

system • 65 
system view order • 66 

delete job from queue • 71 
delete user • 67 

determine job status • 71 
digital markers • 84 
dimensions • 107 
disk 

ejecting CD from drive • 72 
space available • 77 

Dismiss button • 31 
display • 24 

AEC region used • 94 
Dorsal/Ventral hanging • 84 
dose/entrance surface exposure information • 95 

E 
edit 

edit user • 67 
patient data • 55 

edit user • 67 
add or edit • 67 
delete • 67 

Edit View button • 87 
Eject CD • 72 
electrical input • 109 
Emergency Off switches • 28 

restart dialog box • 38 
enhancement tools list • 85 
enter new patient data • 54 
entrance surface exposure display • 95 
environment • 108 
exam room door indicators • 13 
exposure 

duration • 13 
information • 95 
ready indicators • 82 

exposure index • 95 
exposure techniques 

select the mode • 26 
select with function keys • 26 
used • 74 

F 
FAST paddles • 43 
files, select and unselect for import • 73 
film label area, location • 84 
film printer • 22 
filter, select with function key • 26 
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focal spot, select • 26 
footswitches • 9 
Full Zoom/Pan • 88 
function keys • 25, 26 

G 
Gantry 

circuit breaker location and function • 22 
controls and displays • 28 
Emergency Off switches • 28 
restart mobile with VPOS • 122 
rotation switches for C-arm • 28 

Gantry ID • 78 
Generator Status • 82 
grid in/out position toggle key • 26 

H 
hanging options • 84 

I 
image display area • 83 
image enhancement and annotation tools • 85 
Image Management 

Repreview • 75 
Resend • 74 
using • 70, 74, 75 

image processing display • 95 
image receptor 

aligning localization paddle with • 49 
no heat on • 9 
rotation switch • 29 
storage temperature • 108 
technical information • 116 

Image Repetition • 97 
image status • 95 
images 

comments • 86 
film labeling area • 84 
identifying • 54 
import files from CD • 73 
outputs • 58 
Preview screen • 83 
processed • 95 
rejected • 97 
remaining space for • 77 

repreviewing • 75 
resending • 74 
Review dialog box thumbnails • 97 
rules for automatic reclamation • 77 
sizes • 116 
tools • 85 
viewing full resolution • 92 

Implant Present • 81 
button • 88 

import 
image files • 73 
priors in background • 75 

indicator, exam door • 13 
Info menu • 77 
initials, where used • 67 
initiating x-ray exposure • 25 
integrity checklist, mobile • 125 
intended uses • 1 
interlocks • 14 
international symbols • 7 

J 
job status, determine • 71 
jobs in queue • 58, 80 

K 
keyboard • 25 

function keys, set exposure techniques • 26 
keypads • 25 
kV, select • 26 
kV/mA range • 114 

L 
label locations • 17 
laser printer • 9 
Launch dialog box • 31 
light field lamp • 33 
localization paddle • 46 

aligning crosshair device with • 49 

M 
Magnification 

crosshair device • 49 
paddles • 46 
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platform • 47 
Magnification button • 92 
Manage Queues • 71 

delete (cancel) job status • 71 
determine job status • 71 

manual collimation, effects • 65 
Markers 

digital • 84 
mAs 

focal spots manual range • 114 
select • 26 

Measurement button • 91 
Menu bar • 64 
mobile information • 121, 125 
mobile system 

C-arm position switch • 121 
integrity checklist • 125 
safety considerations • 122 
specifications • 123 
temperature/humidity control requirements • 

122 
tests, pre/post transport • 124 
Vertical Position Override Switch (VPOS) • 

121, 122 
modality worklist provider, query • 53 
monthly system tests • 38 
mouse • 25 

N 
New 

Patient • 54 
New Entry function key • 26 

O 
on and x-ray buttons • 25 
operating conditions • 108 
operating conditions, mobile systems • 123 
Operating System (OS) • 31 
outputs 

add new output group • 68 
change/select destinations • 58 
edit output group • 68 
send accepted rejected images to • 97 

P 
paddles 

identification • 45 
realigning front edge with image receptor • 44 

Panel Power dialog box • 38 
Patient 

add new • 54 
edit data • 55 
Face Shield • 13 
protecting from reclamation • 70 
unprotect • 70 

Patient Name, tab for local database • 53 
pixel count • 95 
positioning, optimized for small breast with Smart 

Paddle • 43 
post start-up tests • 33 
power failure • 9, 39 
Power On 

button • 25, 31 
indicator light • 25 

PPS status • 75 
menu item • 64 

preventive maintenance • 9, 105 
Preview Image 

screen • 83 
tools • 83 

printer • 75 
copies of images • 74 
print data on film • 22 

procedure 
close with function key • 26 

Progressive Preview • 83 
Protect Patients • 70, 77 

Q 
Quality Control 

controls and functions tests • 33 
query 

Modality Worklist • 53, 99 
retrieve priors • 75 
retrieve priors, results • 75 

Query button • 99 
queues 

managing • 71 
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Quick Zoom/Pan • 88 

R 
radiation symbol, X-ray indicator • 25 
raw image status • 95 
Ready • 82 
Region of Interest (ROI), button • 89 
region used to calculate exposure index • 95 
reject 

Accepted image • 98 
image • 96, 97 

Reject button • 96, 98, 99 
Remove Unexposed Views • 81 
Repreview, using • 75 
reprint images • 74 
Resend Stopped Job • 71 
restart 

Gantry with mobile VPOS • 122 
system after Emergency • 38 

restart system in Sleep mode • 38 
retract/engage grid • 26 
Retrieve Priors • 75 
Review button • 97 
Review dialog box 

thumbnails, accepted images • 97 
view tab • 97, 98 

review reject Accepted image • 98 
Rotation Angle displays • 28 
rotation switches 

C-arm and Gantry • 33 
Gantry • 28 

S 
safety 

isolation integrity • 9 
mechanical • 13 
mobile requirements • 122 
radiation • 13 

screens 
Preview Image • 83 
Review dialog box • 97 
View Order Editor • 66 

search 
hints for use • 54 
Local Exams • 99 

retrieve priors • 75 
select 

AEC position with keyboard • 26 
breast density in TEC mode • 26 
exposure techniques • 26 
grid position • 26 
outputs • 58 

Select a Patient screen • 52 
send 

accepted rejected images to outputs • 97 
images to an output-post procedure • 74 

Set Rejected button • 98 
Set Technique Defaults screens • 65 
shield 

patient face • 13 
radiation • 13 

Smart Paddle, functions • 33 
Smart paddles • 43 
SMPTE pattern • 76 
software version • 77 
specifications, mobile • 123 
Standard Setup screens • 65 
status, image • 95 
stopped job in queue, resend • 71 
switch users • 40 
switches 

AWS and Value Console circuit breakers • 22 
Gantry circuit breaker • 28 
Vertical Position Override • 122 

symbols, international, defined • 7 
system 

controls and functional tests • 33 
restart in sleep mode • 38 
tests after transport • 125 

system messages • 79 
system tests • 38 

T 
TEC 

select Exposure Mode with keyboard • 26 
technical information 

exposure modes • 117 
printers • 119 

technologist, default view order • 80 
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Refer to the corporate website for more facilities worldwide. 
www.hologic.com 
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